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Preface

How to use this guide

This guide is designed to cater for new SYSPRO Manufacturing Operations Management
implementers.

Included in this guide are Scenarios. These scenarios provide you with an opportunity
to practically apply the steps in SYSPRO Manufacturing Operations Management using
a realistic scenario, which will enable you to integrate what you have learned back into
your day-to-day responsibilities.

Attempt these tasks using the scenario and refer to the built in contextual help if you
need more assistance.

At the end of some topics you will find assessments to help consolidate your learning.

The Outdoors Company

The OUTDOORS Company is a fictitious company created especially for training.

You will be working with The OUTDOORS Company (Company ID MOM) for this
installation.

Note:

The SYSPRO Training Data is available on the InfoZone. However, you need to
request a license for this training company from your territory office.

The Manufacturing Operations Management (MOM) Software is available on the
InfoZone. However, you need to request a license for MOM software from your
territory office.

Do not extract the data on a live system. This data is intended for a standalone
training environment.

The OUTDOORS Company was established in 2001. The company's initial operations
covered the manufacturing and distribution of finished cycles, helmets and garden
furniture products for resale to the trade and the general public.

In recent times, it has added a specialized projects division, whereby it supplies custom
designed garden furniture, including the installation of complex outdoor entertainment
areas for commercial companies.This is geared to provide a total solution to the customer
from design and manufacturing through to the commissioning of the products on site.

The company aims to meet stated customer service levels, produce high quality goods,
and deliver on time, while making a profit.

The Executive of the company has formulated the long-term strategy and objectives of
the organization covering a two year period in the future.
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The Marketing department analyzed the sales history for the past two years (including
current trends, factors creating demand seasonally, and what the competition is doing)
and generated a forecast of sales for the future of existing and new products.

The Finance executives determined a reasonable financial plan by taking into account
required return on investment, current financial and manufacturing resources, as well
as allowing for future growth. The company executives have decided that a customer
service level of 95% is acceptable. This means that 95 out of every 100 demands for
each item must be met from stock. However, in terms of the projects division, the aim
is to achieve close to 100% of demand.

The OUTDOORS Company is also expanding its business to include their suppliers and
customers in optimizing their supply chain. Through the use of ERP II functionality
(Extending the Enterprise), the company allows customers to order via the Internet, and
the company orders from their suppliers via an automated process electronically.
Prospective buyers can view the availability of models and parts via the company's
corporate web page and order online. Where the projects division is concerned, a very
personalized service is given.

In order to deliver the critical made-in components of the cycle assembly to the assembly
floor, The OUTDOORS Company is using SYSPRO Factory Scheduling functionality to
deliver on time within quality standards. This also allows for the planning and delivery
of products for the projects division, whether outsourced or made in.

The Marketing executive is also developing a closer customer relationship with their
loyal clients.This is enabled by a 360° view of their clients through Contact Management.

The company is divided into three divisions: Manufacturing, Distribution and Projects.

Operating Environment

Some facts about The OUTDOORS Company's operating environment:

• Our local currency is $ and our date is set to the format: month/day/year.

• Our financial year runs from March to February.

• The following Accounts Payable branches are used:

• 00 - Payables Head Office

• 01 - Payables Manufacturing

• 10 - Payables North

• 20 - Payables South

• 30 - Payables East

• The following Accounts Receivable branches are used:

• 10 - Receivables North

• 20 - Receivables South

• 30 - Receivables East

• The following banks are used:
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Note:

Foreign currency rates are for training purposes only and may not reflect the
true rates ruling at the time of this training.

• FB - First United Bank

• GB - Global Bank

• NB - National Bank - National Bank is a foreign currency bank account.

• Geographic areas include:

• E - Eastern Region

• N - Northern Region

• O - Overseas

• S - Southern Region

• Product classes and salespersons are linked to products and branches.

• The following warehouses are used:

• Distribution

• N - Northern Region

• S - Southern Region

• E - Eastern Region

• R - Returnables

• Manufacturing

• FG - Finished Goods

• FS - Floor Stock

• RM - Raw Materials

• SA - Sub Assembly

• SP - Specials for Product Configuration and Customized products for
Projects Division

• The OUTDOORS Company runs on average costing for the distribution and the
specials warehouse and standard costing for the manufacturing warehouses.

• We are using simple pricing.

• Stock is not allowed to go into negative, except for in the floor stock warehouse.

• Distribution products include junior and adult mountain bicycles, as well as racing
bicycles and bicycle accessories.

• Manufacturing products include bicycles and garden furniture, which comprises of
green and white tables, chairs, and benches.
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Setting up the training environment

You must complete the installation of Manufacturing Operations Management (MOM)
Suite by following the Installation Guide for Manufacturing Operations Management
provided as a separate document to this training guide.

Note:  As a quick check refer to the information listed below.

You MUST install the following server features:

• Visual APS Server (includes APS Client)

Build 9.16

• Manufacturing Operations Management Web Site

Build 3.8

• SmartLYNQ Web Site

Build 5.7

This training guide works with the builds shown above. All features can be installed on
one computer for training purposes.

The MOM suite uses e.net business objects to communicate with different modules.

Note: SYSPRO 8 needs to be installed and working. For detailed information
refer to the SYSPRO 8 Installation Guide.

1. Microsoft SQL Server 2016 or higher needs to be installed.
2. The MSSQLSERVER Service must be running.
3. Download the MOM Training data from the InfoZone > Links > Training Data.
4. Run the exe to C:\SYSPRO.
5. Attach the sysprodbMOM and SysproCompanyMOM
6. Add a training login and give this login datawriter and datareader rights to the above

two databases.
7. The following MOM databases need to exist:

• MOM_MOM_Data
• MOM_MOM_Config
• MOM_MOM_Logic

8. The thinklynqserivce login needs to have public and dataowner rights to the above
three MOM databases and SysproCompanyMOM as well.

9. The following Services need to be running:

• SYSPRO8enetCommunications
• SYSPRO8ServiceUpgradeManager
• SYSPRODeploymentSupportService
• LynqMEAutocall_MOM_MOM

10. It is very important to have IIS 7.0+ with .NET Extensibility enabled.
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Below are SYSPRO software requirements and parameters on how to setup the software.

SYSPRO 8 Service Upgrade Manager

Prerequisite

• Microsoft .NET Framework 4.6

Description and considerationsParameter

Default provided: 30140
Enter a port number

You can choose to accept the default provided, or manually change to
that which you require.

For best practice, enable this option to ensure that the port number is
added to your firewall.

Add port to firewall

Default provided:
Destination Folder

C:\Program Files\SYSPRO\SYSPRO 8 Service Upgrade Manager.

You can choose to accept the default provided, or manually change to
that which you require.

SYSPRO 8 e.net Communications Load Balancer

• Microsoft .NET Framework 4.6
• SYSPRO 8 Service Upgrade Manager
• SYSPRO 8 Server

Description and considerationsParameter

This field is only applicable if you have SYSPRO 7 Update 1 installed.
Do you want to upgrade the
existing installation

Enabling this option will result in your existing SYSPRO 7 Update 1 service
being upgraded.

Default provided: 0
SYSPRO 8 Application Server
Instance

You can choose to accept the default provided, or manually change to that
which you require.

When SYSPRO 8 is installed, an available BaseDir entry is created for
SYSPRO 8.

The BaseDir entry can be found under:
HKEY_LOCAL_MACHINE\SOFTWARE \SYSPRO\e.net solutions.

This will be used by communication services, both client-server and e.net
related services, to target the SYSPRO 8 files under the specified path in
the BaseDir entry

Default provided: 31001
Enter a SOAP port number

You can choose to accept the default provided, or manually change to that
which you require.

For best practice, enable this option to ensure that the SOAP port number
is added to your firewall.

Add SOAP port to firewall

Default provided: 31002
Enter a REST port number

You can choose to accept the default provided, or manually change to that
which you require.
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SYSPRO 8 e.net Communications Load Balancer

• Microsoft .NET Framework 4.6
• SYSPRO 8 Service Upgrade Manager
• SYSPRO 8 Server

Description and considerationsParameter

For best practice, enable this option to ensure that the REST port number
is added to your firewall

Add REST port to firewall

Default provided: 5
Specify the number of load
balancing processes

You can choose to accept the default provided, or manually change to that
which you require.

Enable this option to define a port for the Basic HTTP protocol.Basic http port required

Default provided: 31003
Enter a Basic port number

You can choose to accept the default provided, or manually change to that
which you require.

Enable this option to define a port for the WS HTTP protocol.Ws http port required

Default provided: 31004
Enter a Ws port number

You can choose to accept the default provided, or manually change to that
which you require.

Default provided:

C:\Program Files\SYSPRO\SYSPRO 8 e.net Communications
Load Balancer

Destination Folder

You can choose to accept the default provided, or manually change to that
which you require.

SYSPRO 8 Communications Service (requires SYSPRO 8 Upgrade Manager to be installed)

PrerequisiteProduct

• Microsoft .NET Framework 4.6
• SYSPRO 8 Service Upgrade Manager
• SYSPRO 8 e.net Communications Load Balancer

Description and considerationsParameter

This field is only applicable if you have SYSPRO 7 Update 1 installed.
Do you want to upgrade the
existing installation

Enabling this option will result in your existing SYSPRO 7 Update 1 service
being upgraded.

Default provided: 0
SYSPRO 8 Application Server
Instance

You can choose to accept the default provided, or manually change to
that which you require.When SYSPRO 8 is installed, an available BaseDir
entry is created for SYSPRO 8. The BaseDir entry can be found under:

HKEY_LOCAL_MACHINE\SOFTWARE \SYSPRO\e.net solutions.

This will be used by communication services, both client-server and e.net
related services, to target the SYSPRO 8 files under the specified path
in the BaseDir entry.
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SYSPRO 8 Communications Service (requires SYSPRO 8 Upgrade Manager to be installed)

PrerequisiteProduct

• Microsoft .NET Framework 4.6
• SYSPRO 8 Service Upgrade Manager
• SYSPRO 8 e.net Communications Load Balancer

Description and considerationsParameter

Default provided: net.tcp://localhost:31001/SYSPROWCFService
SYSPRO 8 e.net
Communications Load Balancer
Endpoint You can choose to accept the default provided, or manually change to

that which you require.

Default provided: SYSPRO 8 Communications
Enter a service name

You can choose to accept the default provided, or manually change to
that which you require.

Default provided: Service used for client-server communication of
SYSPRO

Enter a service description

You can choose to accept the default provided, or manually change to
that which you require.

Default provided: 30110
Enter a port number

You can choose to accept the default provided, or manually change to
that which you require. The recommended range is from 1024 - 49151.

For best practice, enable this option to ensure that the port number is
added to your firewall.

Add port to firewall

Default provided:

C:\Program Files\SYSPRO\SYSPRO 8 Communications
Service\30110

Destination Folder

You can choose to accept the default provided, or manually change to
that which you require.

Note:  Do not progress through this guide until the environment has been installed
and upgraded.
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Introduction

Overview

SYSPRO's Manufacturing Operations Management solution can help you revolutionize
your company to gain competitive advantage in today's market. It provides complete
manufacturing life cycle management from scheduling, publishing, collecting, tracking
and analyzing to optimize and improve end-to-end manufacturing operations. Together
with SYSPRO's ERP this Manufacturing Execution System (MES) offers a unique level
of delivery, cost and quality control of manufacturing operations for job shop, batch
production, production line and mixed mode environments.

The solution helps manufacturers:

• Measure performance to drive towards world class standards of operation for
overall equipment effectiveness (OEE), total equipment performance (TEEP) and
overall labor effectiveness (OLE)

• Increase productivity and lower costs by minimizing loss within the business
• Optimize operational efficiencies through better workflow of core manufacturing

activities: schedule, publish, collect, track, analyze and improve
• Connect machines and other devices to digitize the factory (Industry 4.0)

Manufacturing Operations Management enables organizations to generate accurate
schedules that consider constraints around people, machines, tooling and materials.
Manufacturers are then able to ensure they make best use of their available capacity
to deliver to customers faster and in most cost-effective way, with reduced production
costs.

The solution can help you take control of your manufacturing operations and start to:

• Deliver to your customers faster
• Control labor and machine costs
• Reduce downtime and bottlenecks
• Measure and improve product quality
• Increase productivity and output
• Reduce cost to compete

Manufacturing Operations Management seamlessly connects with SYSPRO to offer a
unique level of delivery, cost and quality control of manufacturing operations for job
shop, batch production, production line and mixed mode environments. Using the latest
technologies, Manufacturing Operations Management can effectively schedule, publish,
collect, track, analyze and help to improve both human and machine execution of orders
on the shop floor, providing faster delivery and lowering your production costs.

16Manufacturing Operations Management (MOM) | SYSPRO EDUCATION
Copyright © 2018 SYSPRO (Pty) Ltd. All rights reserved.

All brand and product names are trademarks or registered trademarks of their respective holders.



Process Flow

SYSPRO Manufacturing Operations Management supports your manufacturing life-cycle,
providing you with a 360 view of your production.

• Schedule

quickly and accurately schedule to maximize order fulfilment and resource utilization

• Publish

Publish schedules and job lists with the shop floor and other departments easily

• Collect

collect data from the shop floor from humans and machines

• Track

gain real time visibility of employees, equipment and jobs

• Analyze

access out of the box analytics for Six Big Loss, OLE, OEE and TEEP

• Improve

drive continuous improvement with alerts, issue management and online documents.
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Integration with other SYSPRO Solutions
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Implementation and Configuration
There are two key aspects to an implementation:

• Factory Review
• Master Data Review

Factory Review

Understanding the business requirements is key to a success implementation. The
factory review forms the foundation for the master data review and MOM configuration.
In order to facilitate this, we have provided a factory review document with a number of
questions to be answered. There may be several iterations through this document with
the initial review being at a higher level and subsequent revisions may provide more
detail or action items.

Master Data Review

MOM relies on accurate data within SYSPRO to be maintained. A master data review
should be performed at the start of the implementation process. The SYSPRO Training
Data has been pre-prepared to ensure that sufficient data exists in SYSPRO to allow
MOM to be functional with minimal master data configuration.

We have identified how MOM makes use of various fields and settings in SYSPRO.The
following will provide guidance for reviewing:

• Work Center Maintenance
• Machine Maintenance
• Employee Maintenance
• Structure and Routing Maintenance

• Operations and
• Subcontract operations

• Stock Code Maintenance
• Stock Code Traceability
• Warehouse Maintenance
• Non-productive codes and
• Scrap codes

Work Center Maintenance

APICS refers to a Work Center as a group of similar resources for the purposes of
Costing, Scheduling or Capacity Management.

When implementing MOM consider your work center setup carefully for
scheduling!!
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The following fields are used for integration purposes between SYSPRO and MOM.

MOM InformationField

When adding operations in SYSPRO against a Bill of Materials or a Job ensure
that the correct loading method is selected.

Run time calculation
method:

MOM supports all three methods.Unit; Rate; Block

Note:  If entering time in a routing by a batch quantity use RATE or
BLOCK.

The Number of work operators field entered against a Work Center is linked
to the Maximum Operators field when adding an operation (routing) for the
same work center.

Number of work operators

Note: The Maximum operators may not exceed the number available
in the work center.

Capacity Unit of Measure:
Note:  SYSPRO MOM only supports a Capacity Unity of Measure = Hrs.

Capacity
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MOM InformationField

You can still select a different Time Unit of Measure but you must make sure
that the conversion (factor) is correct.

The Conversion Factor is calculated automatically (Normal capacity / Time per
unit).

If required you can ignore the Factor calculated by selecting the Manual
override field and entering the conversion factor manually.

Enter the conversion here e.g. if entering time into an operation (routing) in
HOURS than select the number of Hours/day.

Productive Units:

• Time per unit/day

Normal capacity should always be shown in hours (hrs) i.e. do not exceed 24
hours.

• Normal capacity per
unit/day

• Utilization percentage

Rates are important as they are specified against an operation (routing) - Work
Center Rate Indicator 1-9, in the Structure and Routings program.

The rate indicator against each operation is used to apply the correct costs
when posting labor transactions from SYSPRO MOM to SYSPRO Work in
Progress.

Work Center Rates

Machine Maintenance

Machines are added in BOM Machine Maintenance program and are required for
scheduling and must be setup to define capacity. Use the Standard time per month
field against each machine to enter the capacity.

You need to consider the association of the machine with the work center for the purpose
of Scheduling and Capacity Management (not only costing) i.e. grouping of similar
machines (resources) in Visual APS.

You are able to group machines different in MOM using the mapping functionality in
Visual APS. When importing subcontract machines (resources) set Infinite Capacity to
ON and Resource Type to Not Defined.

In Visual APS you will setup shifts for each machine to define finite capacity.

Note:  Subcontract machines (resources) should have a 24/7 shift applied.
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Employee Maintenance

Employee records can either be maintained in BOM Employee Maintenance or MOM.

Note: You must have at least one valid Employee record to successfully post
transactions.

Operation Maintenance

The Bill of Material information captured in the Structure and Routing Maintenance
program is NOT read directly by MOM. Only the captured Operation/Routing against
the Job is read and there may be differences between the two records.

MOM InformationField

The operation number against a job defines the sequence of operations when
Scheduling in APS.

Operation

The Time Unit of Measure is taken from the Work Center setup. It can be set to
whatever you like but WILL always be converted to hours for Scheduling purposes.

Time Unit of Measure

Only the Setup time is used in SYSPRO MOM. The Startup time and quantity is
currently ignored.

Setup time

All the Run time fields are supported when scheduling in Visual APS.Run time:

Run time method
Note:  Quantity and time taken fields are enabled wit rate or block are being
used as defined against the Work Center record.Quantity

Time taken

Teardown time is considered in scheduling at the end of the operation after Wait
time.

Teardown time
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MOM InformationField

Wait time is used after Run time and before Teardown time. This is to be used
where the resource is still needed but no quantity is produced. For example, drying
time.

Wait time

Note: You can determine how resources are consumed in Visual APS
settings.

The value entered in Movement time field is used for scheduling after the operation.
Movement time

Parallel operations can be represented by putting any negative value in the
Movement time field. This results in the operation running parallel to the previous
operations

Specify the number of operators required to complete this operation. This figure is
issued when scheduling and can be variable.

Maximum operators

Note: You will not be able to enter a value greater than the number of
operators entered against the work center.

Refer to FLOAT resources in Visual APS for more information.

The machine field does not need a value to be entered for scheduling to work but
at least one machine must be defined per work center. If this field is left blank,

Machine

MOM will assume that the default machine is to be the first machine associated
with the work center in alphabetical order.

Toolset can be specified to identify a secondary resource (multiple constraint) that
is required for this operation.

Toolset

Toolset quantity
The Toolset quantity defines how many tools are required for the operations
(equivalent to operators).

Toolset consumption

Toolset consumption defines how this resource is consumed:

0 as specified;

1 proportional to operators and

2 all available.

The Transfer method and Quantity/percentage fields are used to specify where the
operations overlap. Entering values here result in the operation overlapping the
next operation.

Transfer method and
Quantity/percentage
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Subcontract Operations

MOM InformationField

The Lead time field is not used by Visual APS for scheduling. This field is used for MRP
purposes and represents the purchase lead time.

Lead time

For subcontract operations the Planning Manager uses the Offsite time, Dock to stock
and Movement time to schedule.

Offsite time; Dock
to stock and
Movement time

These are automatically converted from days into hours i.e. x 24. If provided the movement
time is used before the operational time i.e. Offsite time + Dock to stock.

Note:  A subcontract machine (resource) should have a 24 x 7 shift applied and
be set to infinite capacity / Not defined.

Stock Code Maintenance

The Maximum number of decimals field is used when posting material issues and
other quantity transactions from MOM to Work in Progress.
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Stock Code Traceability

SYSPRO has three options for stock code traceability:

1. Serialized - Manual
2. Serialized - Batch
3. Lot traceable

All three of these methods are supported in MOM.

If any of these methods are chosen you must enter a valid serial or lot number when
using Material issues and/or Job receipts in MOM for the transaction to post correctly
to Work in Progress.
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Work Center Maintenance

APICS refers to a Work Center as a group of similar resources for the purposes of
Costing, Scheduling or Capacity Management.

When implementing MOM consider your work center setup carefully for
scheduling!!

The following fields are used for integration purposes between SYSPRO and MOM.

MOM InformationField

When adding operations in SYSPRO against a Bill of Materials or a Job ensure
that the correct loading method is selected.

Run time calculation
method:

MOM supports all three methods.Unit; Rate; Block

Note:  If entering time in a routing by a batch quantity use RATE or
BLOCK.
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MOM InformationField

The Number of work operators field entered against a Work Center is linked
to the Maximum Operators field when adding an operation (routing) for the
same work center.

Number of work operators

Note: The Maximum operators may not exceed the number available
in the work center.

Capacity Unit of Measure:
Note:  SYSPRO MOM only supports a Capacity Unity of Measure = Hrs.

Capacity
You can still select a different Time Unit of Measure but you must make sure
that the conversion (factor) is correct.

The Conversion Factor is calculated automatically (Normal capacity / Time per
unit).

If required you can ignore the Factor calculated by selecting the Manual
override field and entering the conversion factor manually.

Enter the conversion here e.g. if entering time into an operation (routing) in
HOURS than select the number of Hours/day.

Productive Units:

• Time per unit/day

Normal capacity should always be shown in hours (hrs) i.e. do not exceed 24
hours.

• Normal capacity per
unit/day

• Utilization percentage

Rates are important as they are specified against an operation (routing) - Work
Center Rate Indicator 1-9, in the Structure and Routings program.

The rate indicator against each operation is used to apply the correct costs
when posting labor transactions from SYSPRO MOM to SYSPRO Work in
Progress.

Work Center Rates

Non-Productive Code Maintenance

Non-productive codes can be mapped to Diversion Codes in MOM allowing transactions
to be posted back to Work in Progress for financial analysis purposes.

Scrap Reason Maintenance

Scrap Reason codes are used during data collection in MOM i.e. if you scrap a quantity
you must specify a valid scrap reason code for the transaction to successfully post back
to SYSPRO Work in Progress.
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Note:  A default scrap reason code can be added via Integration Settings in MOM.

29Manufacturing Operations Management (MOM) | SYSPRO EDUCATION
Copyright © 2018 SYSPRO (Pty) Ltd. All rights reserved.

All brand and product names are trademarks or registered trademarks of their respective holders.



Navigation

Overview

The MOM interface is made up of the MOM website and Visual APS.

The MOM website provides an interface to:

• Communicate and access resources
• Configure settings
• Post transactions
• Review production issues
• Analyze performance

Visual APS provides an interface to:

• Prioritize job schedules
• Review material requirements
• Plan and schedule jobs

Several processes are outlined below, to help familiarize you with the general flow of
the SYSPRO MOM solution:

1. Finding your way around
2. Configuring for first use
3. Scheduling jobs
4. Viewing published plans
5. Collecting data
6. Tracking progress
7. Analyzing performance
8. Improving performance

Finding your way around

In our example, you will be accessing the SYSPRO MOM Training on your local machine
using the url: http://localhost/MOM_MOM/.
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Description

Company Name: Refers to the company you are working in. MOM relates to the SYSPRO company
id (MOM).

1

User Name: The operator who is currently logged in to the system.
2

As your account is linked to Active Directory you only have to sign in once.

Personal settings: Under Personal setting you can sign in and out or switch to a different user.You
can also set your own language and localization settings or request additional access from your
system administrator.

3

Quick links: Add your own personal bookmarks to frequently used dashboards, views or reports.
You can also add quick links to external Web Sites or other web based systems that you may use.

4
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DescriptionStep

Message Center: Messages and management alerts fro the factory floor.
5

Issue Log: Review, assign and resolve your production issues.
6
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DescriptionStep

Document library: Add files, forms and links to jobs, employees and equipment.
7

Need help?: Access extensive online help with videos and other articles that help you get the most
of the system.

8

News: Keep an eye out for new videos and other news regarding your software via Twitter.9
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DescriptionStep

Let's get started!: Navigate to the main areas of the system.
10

Go to Planning to schedule or publish.

Go to Workforce to collect data from the shop floor or to see the current status of your employees,
equipment or jobs.

Go to Factory to review factory performance analysis.

Configuring for first use

Confirm licensing
1

Start by checking your license details. Find out the number of seats you have available. A seat
is required for all users who will access the system and all resources where data collection is
required.

Setup users
2

Add your system users. Each user will have a login and be a member of a group and role. You
can also set the permissions for each user has from here.

Setup resources
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Staying within user maintenance, you can now setup resources. A resource is any employee or
equipment that you will either schedule to or collect data from. Resources can be imported from
your ERP or PLM system.

Setup shifts
3

Open Visual APS and click on the HOME tab. Add your shifts for scheduling. Shifts allow you to
define your capacity.

Setup terminals
4

Setup and configure the terminals that will be used to collect data from your employees and
equipment.

• Step 1 -

• Step 2 -

• Step 3 -

• Step 4
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• Step 5 -

Scheduling Jobs

• Step 1 - Prioritize your jobs

In Visual APS. Prioritize your jobs using attributes and markers. Apply groups and
filters and then save these as a workflow to build your planning process.

• Step 2 - Review material availability
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Load the jobs you want to schedule and group them using the material availability
icons i.e. no shortages, partial shortage, or no materials.

• Step 3 - Schedule jobs where materials are available

Select your jobs without shortages, right click and auto-schedule. From within the
auto-scheduling dialogue you can set the scheduling sequence to minimize the
changeover time. e.g. blue first, then green, then red and so on…Update the
planning board.

• Step 4 - Review shortages

Return to the jobs with shortages. Run a selected MRP view to see when materials
will become available. If they arrive before the required/promise date, drag and
drop these jobs onto the planning board based on the dates materials will become
available. Note: the material icon turns green to confirm you have no shortages by
the scheduled date.

• Step 5 - Material Issues

Use the markers to mark jobs with material issues. Filter, export and share this list
with your procurement teams for them to expedite with your suppliers. Alternatively,
you may choose to schedule jobs with shortages. Doing this will allow MRP systems
to inform your procurement team of any material supply adjustments.

• Step 6 - Repeat

Repeat steps 2 through 5 for each of your job groups.
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• Step 7 - Review your plan

Go to "Dashboard" to review your planned order fulfilment and equipment utilization.
Use "Equipment Loading" to see the details. For Rough Cut Capacity Planning
use the "Capacity Chart" to add MRP and What-if jobs.

• Step 8 - Firm your plan

Make any adjustments and then fix your plan for your firm planning period by using
"Pins" to lock jobs in place.

Publishing Plans

• Step 1 - Save and publish

Click "Save & Publish" from the Visual APS to sync your plan with your ERP or
PLM system.Your plan is also published to the factory floor in the form of an online
schedule and equipment specific work lists.

• Step 2 - View your schedule online
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Go to "Production Plan" to view your online schedule and check how you are
progressing. Why not make this visible to everyone on the shop floor on a big
screen?

• Step 3 - Print your plans

Do you need to print your plans…? Go to "Production Plan" and select the "Print"
tab. Here you can print a bar-coded production plan for any equipment or date
range

• Step 4 - View your work lists

Go to "Equipment Job List" from your mobile device to access simple work lists
for each piece of equipment based on your schedule.

• Step 5 - Enforce schedule adherence

Change the period filter and configure your terminals to enforce your plan and
make sure that operators only work on the jobs that they should be working on
according to your plan.

• Step 6 - Revise your plan

Go back to "Visual APS". Change your plan based on changes in job progress or
priority. Click "Save & Publish" to update the production plan and shop floor
execution.
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Collecting Data

• Step 1 - Start your day

Go to terminal at the entrance of your building or work area and scan/enter your
employee code to start your day.

• Step 2 - Start your jobs

Go to "Workbench" to start the jobs and begin collecting data. Open your terminal
and click on equipment to view the work list. Click "Start" to begin the job. Click
"Stop" to stop the job. Labor and machine hours will be recorded automatically
against the job.

• Step 3 - Record progress

To record progress against a job and measure performance you must report
operational quantities. Click "Report" to enter the operational quantity that has
been produced so far.

• Step 4 - Record scrap

Click "Report" to enter the scrap quantity. Recording scrap effects the measurement
of quality. Use the scrap reason code to provide the reason for the scrap.

• Step 5 - Record status
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Click "Report" to record the operational status. If you have completed the operation,
mark the status as "Complete".

• Step 6 - Record issues

Go to "Production Issues" to record issues on the shop floor. Issues notifications
are automatically sent to your team lead for assignment and resolution.

• Step 7 - Issue materials

Go to "Material Issue" or "Kit Issue" to issue materials to the job/jobs you are
working on. When posted to Work in Progress inventory will be updated.

• Step 8 - Complete job receipts

If Job Receipting has been enabled, clicking "Report" on the last operation will
allow you to enter the quantity as a job receipt. When posted to Work in Progress
inventory will be updated.

• Step 9 - Record non-productive time

Go to "Meeting", "Training" or other non-productive buttons from within your
workbench terminal. Jobs currently in progress will be paused and non-productive
time will be recorded automatically.

• Step 10 - End your day

Go to "End Day" to finish your day. Your jobs will be stopped, transactions will be
automatically generated, and employee and equipment status will be updated.
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• Step 11 - Review transactions

Go to "Transaction Review" to review and approve transactions created from the
activities during the day.

• Step 12 - Post transactions

Click "SYNC" to post approved transactions to Work in Progress.

Tracking Progress

• Step 1 - Check your overall status

Go to "Dashboard". Here you can see high level status of your jobs and workforce.
Click on the plates to drilldown to the detail.
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• Step 2 - Check employee status

Go to "Employee Status" to check the status of your employees. This screen
provides live status of employee performance and current activity. If you have the
permission you can access the employee workbench from here and see any alerts
and issues they might have.

• Step 3 - Check equipment status

Go to "Equipment Status" to check the status of all your equipment. This screen
provides live status of employee performance and current activity. You can also
see alerts and issues.

• Step 4 - Check job status

Go to "Job Status". Here you can see the status of overall job progress, labor
bookings and material issues. Drill into specific job details by clicking on the link.

• Step 5 - Review job detail

Here you can see the specifics of the job including its schedule, operational and
material progress, attachments, issues and more. Easy indicators let you know
whether the job is on track or not making this screen useful to sales, customer
service and production teams.

Analyzing Performance
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• Step 1 - Performance today

Go to "Employee Status" or "Equipment Status". Here you can you see how each
resource is performing and what every resource you have is working on right now.

• Step 2 - Employee performance

Here you can see how an individual employee has performed over time. Use the
"Dashboard" for a high-level view or click on "Summary" and "Detail" for more
information.

• Step 3 - Team performance

Go to "Employee Analysis". Here you can see how an individual or group or
employees have performed over time. You can also see how many parts they
produced, how much time was productive and the reason why performance was
not 100%.
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• Step 4 - Equipment performance

Here you can see how a specific machine has performed over time. You can also
see why the machine was not 100% productive and where hours were lost.

• Step 5 - Work Center performance

Go to "Equipment Analysis". Here you can see how some or all of your equipment
has performed, how many parts were produced, how much time was productive
and the reason why performance was not 100%.

• Step 6 - Factory performance

Go to "Dashboard" for high level view of OEE (Overall Equipment Effectiveness)
and TEEP (Total Effective Equipment Performance). Why are these not 100%?
See the metrics below. Drill into the metrics for more detailed analysis.

Improving Performance
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• Step 1 - Define

Why is our performance not 100%? What can we do to improve it? These are both
questions answered by the "Loss Management" dashboard.

• Step 2 - Measure

Tree maps identify, classify and quantify your losses. They work on the principle
of the larger the square tile the larger the issue. This lets you target your largest
loss reasons first.

• Step 3 - Analyze

Drill down to investigate and analyze reasons for the loss by each category:
Loading, Availability, Performance and Quality. Use iGrafx ® , Minitab ® or other
statistical process and analysis tools for further investigation.

• Step 4 - Improve

Go to "Production Issues". Here you can create and track your continuous
improvement initiatives. Assign each issue to an owner and track resolution activity.

• Step 5 - Go paperless?
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If loss is as a result of missing documentation why not go paperless and put your
documents online. Click here to attach static files, online forms or link to a document
management system.

Step 6 - Control

Go to metric reports e.g. "Loading". Use comparative reporting to review whether
countermeasures have been successful. Repeat the process to continue to drive
improvement.
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Schedule and Publish - Configuration

Overview

SYSPRO Manufacturing Operations Management has been formed around the
international standard, IEC62264.This standard is illustrated below. It comprises 8 core
activities, which include resource management and definition management.

Resource management deals with the resources required to manufacturer e.g.
machines, tools, labor and materials.

Definition management deals with the rules to produce a product e.g. standard product
routing.

These two activities are delivered by SYSPRO Manufacturing Operations Management
in combination with other modules such as Bill of Materials and Inventory.

Reset Profile Settings -

Note:  Profile settings must be reset in both Visual APS and MOM prior to
completing any steps in the training guide. The profile includes factory defaults for
all configuration settings.

Reset profile settings in Visual APS
The following steps describe how to reset profile settings in Visual APS.
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1. Open Visual APS.

2. Select File Menu.

3. Select Company Settings Menu.

4. Select Reset Settings.

5. Close Visual APS

Re-create default connection settings in Visual APS
The following steps describe how to re-create default connection settings in Visual APS.

After resetting the profile settings in Visual APS you need to re-load Visual APS and
re-create your default connection settings.

1. Open Visual APS.

2. Select File Menu.

3. Select Open.

4. Select New Database Connection.

5. Enter the SYSPRO Database Server Name as the server name or computer name
where the SYSPRO SQL Database resides. Include the SQL instance name if SQL
is not installed as a default instance.

6. Select the Authentication Mode Windows/SQL.

7. Tick the App Role, if you have configured Visual APS to connect to the SYSPRO
database using the Application Role (default setting).

8. Enter the SYSPRO Database Name in the Company field.

9. Select OK.

How to apply a new license from the internet
The following steps describe how to apply a new license from the Internet.

1. From Visual APS click on About.
2. Click on Change Product License.

3. In the Customer Name field type your customer license name.

4. Click on Get License Online.

How to load a new license from a file
The following steps describe how to apply a new license from file.

1. From Visual APS click on About.
2. Click on Change Product License.

3. Select Upload license file manually.

4. Select the license file and select Open.

Companies

How to open a company from an existing Company list
The following steps describe how to open a company from an existing company list.
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1. Select Open from the Visual APS File Menu.

2. Click the Arrow next to New Database Connection.

3. Select the Server […]

4. Select the Company […]

5. Click OK.

How to switch companies
The following steps describe how to switch companies.

Use the Tabs at the top of the window to select which company you require.

System Site Settings

System settings are accessed from the MOM home page by clicking on the Settings
roundel in the top right-hand corner of the screen. Site settings are configured
automatically by the installation wizard.

MeaningFieldSection

Site Display NameCompany NameGeneral Settings

Append Database Name to site NameAdd ERP Database Name

Default Site LocalizationLocalization

Default Site LanguageLanguage

Site Administrator(s) separated by semi
colon

Administrator

Administrators email addressAdmin e-mail address

Email address for all MessagingAddressEmail Settings

From address for all MessagingFrom

Alias address for all MessagingAlias

SMTP Server addressServer

SMTP Port NumberPort

Mailbox accountAccount

Mailbox passwordPassword

SSL required/not requiredEnable SSL

Time in seconds for caching to occurTasksData Caching Interval

Time in seconds for caching to occurTask Schedules

Time in seconds for caching to occurOperations

Time in seconds for caching to occurMaterials

Time in seconds for caching to occurJobs

Time in seconds for caching to occurEmployees
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MeaningFieldSection

Time in seconds for caching to occurEquipment

Time in seconds for caching to occurAPS Planning Statistics

Database connection string details for
SYSPRO Database

SourceDatabase Settings

Database connection string details for
MOM Data Database

Data

Database connection string details for
MOM Config Database

Config

Database connection string details for
MOM Logic Database

Logic

SmartLYNQ site nameHostIntegration Setting

SmartLYNQ Service nameService

SmartLYNQ instance nameInstance

Database Settings connect MOM to SYSPRO. These settings are configured
automatically during the installation. Do not make changes to these settings. If the
instance of MOM should be re-configured to a different SYSPRO company, another
instance of MOM should be installed or the Repair option should be run through the
Product Updater to re-map the instance to another company. These settings should not
be changed unless the location or other key information concerning your SYSPRO
system has changed.

Recreate Views should be run with caution as SQL views may be customized.
Customizations are not re-applied when selecting the option to recreate views.

Email Settings must be configured to send external emails from Smart Manager, settings
relating to your email setup need to be configured. Clicking on Test Connection will allow
you to test the Emails Settings are set correctly.

Data Caching Intervals are used to determine the frequency at which data is cached
from SYSPRO to MOM. For training demonstration purposes, it is recommended that
these settings are set low (i.e. every 5 seconds). The default settings for caching are
based on production environments

Integration Settings must be configured when using the Document Library and to
enable the manual SYNC functionality from the Transaction Review screen. These
settings are using to link MOM to the SmartLYNQ application. These settings should
not be changed unless the location or SmartLYNQ has changed or the instance of in
SmartLYNQ has changed.

General Settings

General settings are used to manage default application settings in relation to data
collection, display of decimals, group security and data management. The application
is shipped with these default settings.

Data Collection

Out/OffEquipment status (default)
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Out/OffEquipment status (default)

14.0Clock out warning after (hrs)

600Terminal timeout after (secs)

Office TimeClocked time (default)

TrueStore data at lowest level?

FalseOpen Workbench from Current Status

Operation SelectionData selector (default)

1000000.00Report quantity (maximum)

1000000.00Report scrap (maximum)

Split equipment view lookups to Primary/SecondarySplit equipment by primary type

Display Decimals

2Hours

2Quantities

2Other

Group Security & Messaging

FalseDirect (single level)

FalseDependent (multi-level)

Data Management

FalsePurge data automatically

FalsePurge data older than (days)

FalseStart purge at (hh:mm)

Groups

Groups are used to organize seats into a hierarchical structure which models those
found in your organization. The groups in the following table are shipped with the
application.

Use groups to define your organizational structure for security and messaging

RoleDescriptionGroup

AdministratorsAdministratorsAdministrators

EngineeringEngineering

FinanceFinance

Human ResourcesHR

Planners, ManagersManufacturing operations and
planning

Manufacturing

Workforce, ManagersProduction managersProduction

WorkforceLine ManagerLine 1

SupervisorsSupervisor (Line 1)Supervisor (1)
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RoleDescriptionGroup

WorkersWorkers (Line 1)Workers (1)

WorkforceLine ManagerLine 2

SupervisorsSupervisor (Line 2)Supervisor (2)

WorkersWorkers (Line 2)Workers (2)

PurchasingPurchasing

SalesSales

Groups are used for transaction approval and messaging purposes within Workforce
Manager.The group security and messaging settings under Settings, Advanced Settings,
General, determine:

• What transactions (by employee) are visible in the Transaction Review.
• Whose messages are sent to when an employee sends a message from the

Workbench.
• Which employees/equipment an alert is based on and who will receive alerts.

MeaningSecurity Setting

Only the immediate level in the group structure is applied.Direct (Single Level)

All levels including the immediate level and below in the group
structure is applied.

Dependant (Multi Level)

Adding a new group
The following steps describe how to create a new group.

Hi Colin,

We are expanding our production lines and require a 3 rd line to be created beneath the Production Group.
The new line should replicate the same configuration as line 1 and line 2. The owner of the 3 rd production
line is JSmith who is already a user of the system. We will confirm later the users that need to be added to
this new 3 rd production line. Please action at your earliest convenience.

Thanks

1. Select Planning Manager.
2. Select User Maintenance.

3. Select the Groups tab.

4. Highlight the Production group within the hierarchy.

5. Select New.

6. Enter Line 3 in the Name field and Line Manager in the Description field.

7. Under the Owners tab select JSmith.

8. Select Save.

9. Highlight the Line 3 group within the hierarchy.

10. Select New.

11. Enter Supervisor [3] in the Name field and Supervisor (Line 3) in the Description
field.

12. Select Save.

13. Highlight the Supervisor [3] group within the hierarchy.
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14. Select New.

15. Enter Workers [3] in the Name field and Workers (Line 3) in the Description field.

16. Select Save.

Viewing, printing and exporting a list of groups
The following steps describe how to view, print and export a list of groups held on file.

You need to ensure that you have added the group as requested.

1. Select Planning Manager.
2. Select User Maintenance.

3. Select the Groups tab.

4. Select Export.
5. Select Close.

Roles

Create roles to provide your employees with appropriate rights based on their
responsibilities

Roles comprise of one or more built-in rights.You can create your own roles to suit the
responsibilities within your organization. Groups can be associated with one or more
roles. The built-in roles shipped with the application and their associated rights include:

Functional AreaModuleRole Name

AllAllAdministrators

Documents Issue Log Message Center
All

Syspro MOM Factory ManagerManagers

Documents Grid Settings Issue Log
Message Center All

Syspro MOM Planning ManagerPlanners

Except for: Advanced Settings Resource
Maintenance Settings

AllSupervisors

Message Center WorkbenchSyspro MOM Workforce ManagerWorkers

Documents Grid Settings Issue Log
Message Center All Employee Analysis
Loading

Syspro MOM Workforce Manager
Factory Manager Factory Manager

Workforce

Adding a new role
The following steps describe how to create a new role.

Hi Colin,

We would like to create a new role called Workers + which provides access to the Message Center, Employee
Status, Employee Details and the Workbench. Please action at your earliest convenience.

Thanks

1. Select Planning Manager.
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2. Select User Maintenance.

3. Select Roles.

4. Select New.

5. Enter Workers + in the Name field and Workers + in the Description field.

6. From the Rights tab check on the functional areas:

Message CenterSYSPRO MOM

Employee StatusWorkforce Manager

Employee Status Details

Workbench

Viewing, printing and exporting a list of roles
The following steps describe how to view, print and export a list of Roles held on file.

You need to ensure that you have added the role as requested

1. Select Planning Manager.
2. Select User Maintenance.

3. Select on the Roles tab.

4. The Roles should display as illustrated below

5. Select on Export.
6. Select on Close.

User Rights

Rights

Control access permissions within your roles

Rights are used to assign permissions to a role. Rights cannot be amended or deleted.
The rights in the table below are created when the application is installed.

Factory ManagerWorkforce ManagerPlanning ManagerSmart Manager

AvailabilityAlert MaintenanceUser MaintenanceAdvanced Settings

DashboardDashboardDashboardDocuments

Employee AnalysisEmployee PerformanceEquipment Job ListGrid Settings

Equipment AnalysisEmployee StatusEquipment LoadingIssue Log

Issue MaintenanceEmployee Status DetailEquipment PlanMessage Center

LoadingEquipment DetailsMaterial ListResource Maintenance

Loss ManagementEquipment PerformanceProduction HistorySettings

PerformanceEquipment StatusProduction Job List

Product AnalysisJob CardProduction Plan

QualityManagement Reports

Job Status
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Factory ManagerWorkforce ManagerPlanning ManagerSmart Manager

Terminal Maintenance

Timesheet Entry

Transaction Review

Workbench

Employees

Setting up your resources for scheduling and data collection

In the previous lesson you learned that users must be created in MOM. These users
are windows accounts assigned to one or more groups.The group assignment determines
which functional areas of the application the user will have access to.

Employees/Equipment

Before a user can perform data collection activities through the workbench they will need
an active employee record. In addition, if a user wants to track any activity outside of
the workbench against an employee, the employee record must be activated in MOM.
The same also applies to data collection for equipment.

MOM provides an option to import resources from Work in Progress, avoiding the need
to create resources manually in both MOM and Work in Progress.The only pre-requisite
for importing resources into MOM is:

• Employee has been created in Work in Progress.
• Equipment (machine) has been created in Work in Progress

During the implementation of MOM, all resources must be created and imported into
MOM where appropriate. Each resource should be configured appropriately.

Adding an employee in Work in Progress
The following steps describe how to create a new employee in Work in Progress.

Hi Colin,

We have a new worker 'Justin Andrews' joining the company and we need to set him up so he can collect
data in MOM using the workbench feature. Please action at your earliest convenience.

Thanks

1. Open the Employees program in Work in Progress > Setup > Employees.

2. Enter 123456 in the Employee field and press Tab.

3. Enter Justin Andrews in the Name field.

4. Save the changes.

5. Exit the program.

Importing employee from Work in Progress
The following steps describe how to import a new employee from Work in Progress

1. Select Planning Manager.
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2. Select User Maintenance.

3. Select Import.
4. Select Employees.

5. Select Justin Andrews.

6. Select on OK.

7. Tick Employee Justin Andrews.

8. Select Activate.

Note: When importing an employee, the workbench ID will automatically be
set to the employee ID. Once activated, the employee can clock into the
workbench using their employee ID. 1 activated employee consumes 1 seat
from the license allowance.

Adding an employee in MOM
The following steps describe how to create a local employee.

Hi Colin,

We have a temporary worker 'Sam Smith' joining the company and we do not plan to maintain an employee
record in Work in Progress. He will only be working for the company for 1 month and will perform data
collection activities in MOM via the workbench. The Work In Progress Temporary employee account TEMP
must be used for any transactions posted to Work in Progress. He will be the operator of DRIL01 during this
time. I believe MOM allows you to create a local employee record for this purpose. Please action at your
earliest convenience.

Thanks

1. Select on Planning Manager.
2. Select on User Maintenance.

3. Select on Seats.

4. Select on New.

5. Select on New Employee.

6. Select the User type Workbench.

7. Enter Temporary in the First Name field.

8. Enter Worker in the Last Name field.

9. Enter TEMP1 in the Workbench ID field.

10. Enter TEMP in the Employee ID (ERP) field.

11. Select DRIL01 from the Equipment Code field.

12. Select on Save.

13. Select on Close.

Setting employee properties

MOM allows additional properties to be set against an employee. The training guide
does not provide scenarios for all possible property values but the following can be used
for reference.
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ValueFieldSection

Seat is active/inactiveActiveGeneral

Photo of employeePhoto

Default crew for employeeCrew

Employee's first nameFirst Name

Employee's last nameLast Name

Employee's display nameDisplay Name

Default no of resourcesNo. of ResourcesResources

Clocked Time
Planned Busy Time

• Availability is calculated as
relation between actual Up
time to actual Total time.

Basic Calendar

• Availability is calculated as
relation between actual up
time to basic calendar value
of planned hours for a
specified day.

Visual APS - Resource Calendar

• Availability is calculated as
relation between actual Up
time to Planned Up as per
Visual APS schedule for
s p e c i f i e d  W o r k
Center/Machine.

ID for accessing the workbenchIDWorkbench

Password to access the workbenchPassword

Difference between employee's
time and the MOM server time.

Time zone offset

The group the employee belongs
to.

Group Name
Groups

Employee groups are integrated
with messaging and alerts and can
also be used to restrict certain
functionality within the workbench.

Viewing, printing and exporting a list of employees
The following steps describe how to view, print and export a list of employees held on
file.

You need to ensure that you have added all employees required for MOM.

1. Select on Planning Manager.
2. Select on User Maintenance.

3. Select on Seats.

4. Change the Filter Sliders to only show Employees.

58Manufacturing Operations Management (MOM) | SYSPRO EDUCATION
Copyright © 2018 SYSPRO (Pty) Ltd. All rights reserved.

All brand and product names are trademarks or registered trademarks of their respective holders.



5. Confirm all users have been added. (export users if required)

Equipment

Typically manufacturing equipment records (Machines) are maintained in SYSPRO.
These records can be imported into MOM by using the Import Equipment function. An
equipment record will be created based on the machine code and the Work Center the
equipment belongs to. If the machine is moved to another Work Center in SYSPRO,
the equipment record should be deleted and re-imported in the application.

Adding a machine using Work in Progress
The following steps describe how to create a new machine in Work in Progress.

Hi Colin,

The drill that I ordered last month has now been delivered to the drill Work Center. Please can you add the
drill against the DRILL Work Center in Work in Progress.

Please action at your convenience.

Thanks

1. Open Work in Progress > Setup > Machines.

2. Enter DRIL05 in the Machine field and press Tab.

3. Enter Drill Machine 05 in the Description field.

4. Enter DRILL in the Work Center field.

5. Save the changes.

6. Exit the program.

Importing machines from Work in Progress to Visual APS
The following steps describe how to import machines from Work in Progress to Visual
APS.

This function is run during the implementation of MOM and must be run after you add
new machines in Work in Progress

1. Refresh Visual APS.

2. Select on Home.

3. Select onImport.
4. Set the Resource type to Machine - Machine Hours.

5. Leave the shift as Default - Default Shift.
6. Select on OK.

7. Expand the DRILL Work Center.

8. Select the DRLL05 machine.

9. Select on OK.

Note: When importing equipment, the workbench ID will be automatically set
to the internal equipment ID. Once activated, the equipment can be used for

59Manufacturing Operations Management (MOM) | SYSPRO EDUCATION
Copyright © 2018 SYSPRO (Pty) Ltd. All rights reserved.

All brand and product names are trademarks or registered trademarks of their respective holders.



data collection. 1 activated equipment record consumes 1 seat from the license
allowance.

Default Machine Settings

Default machine settings when importing from Work in Progress to Visual APS .

Visual APS allows additional properties to be set against a machine. The training guide
does not provide scenarios for all property values but the following can be used for
reference.

ValueFieldSection

Indicates no limits to capacityInfinite ResourceResources

Type of resourceResource Type

Default No. of ResourcesDefault Resource Qty

Float Resources based on TypeFloat Resource Usage

All/Less or Equal/Greater or EqualFloat Resource Usage Type

Float Resources based on min/maxFloat Discrete Resource Usage

Min no. of resources requiredMin Resource Consumption

Max no. of resources requiredMax Resource Consumption

Recommended load level percentageRecommended Load Level (%)

Minimum time during which a task can be
started when splitting tasks

Split Task Consumption (Min)

Maximum time interruption when splitting
tasks

Split Task Interruption (Max)

Default shiftShiftShifts

Importing machines to Manufacturing Operations Management
The following steps describe how to import machines into MOM.

1. Select Planning Manager.
2. Select User Maintenance.

3. Select Import.
4. Select Import Equipment.
5. Select the DRIL05 machine.

6. Select OK.

7. Tick DRIL05.

8. Select Activate.

Setting Equipment Properties

MOM allows additional properties to be set against equipment. The training guide does
not provide scenarios for all possible property values but the following can be used for
reference.
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ValueFieldSection

Seat is active/inactiveActiveGeneral

Photo of equipmentPhoto

Work Center equipment belongs toWork Center

Equipment (machine) codeEquipment

Equipment display nameDisplay Name

Work in Progress or MOMSourceProperties

Manual or AutoUser

Internal identification numberEquipment ID

Work in Progress machine codeMachine (ERP)

The group the equipment belongs
to. Groups are integrated with

Equipment Group

messaging and alerts and can also
be used to restrict certain
functionality within the workbench.

UOM for the work Center the
equipment belongs to

Capacity UOMCapacity

Default no. of resourcesNo. of resources

Clocked Time
Planned Busy Time

• Availability is calculated as
relation between actual Up
time to actual Total time.

Basic Calendar

• Availability is calculated as
relation between actual up
time to basic calendar value
of planned hours for a
specified day.

Visual APS - Resource Calendar

• Availability is calculated as
relation between actual Up
time to Planned Up as per
Visual APS schedule for
s p e c i f i e d  W o r k
Center/Machine.

ID for accessing the workbenchIDWorkbench

Password to access the workbenchPassword

Difference between equipment's
time and the MOM server time

Time zone offset

Viewing, printing and exporting a list of equipment
The following steps describe how to view, print and export a list of equipment held on
file.

You need to ensure that you have added all equipment required for MOM.

1. Select Planning Manager.
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2. Select User Maintenance.

3. Select Seats.

4. Change the Filter Sliders to only show Equipment.
5. Confirm all equipment has been added. (export equipment if required)

Assessment: Resources

1. Explain the steps required to add a new employee to MOM from Work In Progress?

A. User Maintenance > Seats > New > New Employee

B. User Maintenance > Seats > Activate

C. User Maintenance > Seats > Import > Import Employees

D. Resource Maintenance > Employee > Employee Maintenance

2. Explain the steps required to add a new machine to MOM?

A. User Maintenance > Seats > New > New Equipment

B. User Maintenance > Seats > Activate

C. Resource Maintenance > Equipment > Equipment Maintenance

D. User Maintenance > Seats > Import > Import Equipment

3. Which feature on the Home Menu in Visual APS should be used to configure
variations in time factors?

A. Machines

B. Alternatives

C. Constraints

D. Mapping

4. During the implementation of MOM all resources must be created in Work In Progress
and imported into MOM where appropriate.

A. True

B. False

5.
Hi Colin

We have a new worker 'Frank Lee' who will be the operator of a special drill we have purchased for
the drilling Work Center. The drill will arrive next week and both his employee account and equipment
record must be setup in Working in Progress and MOM.
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Employee Code: 123457 Equipment Code: DRIL07

Please action at your earliest convenience.

Thanks

Shifts

Creating and assigning shifts to your resources to define your capacity

In the previous lesson you learned how to create resources in MOM. Before a resource
can be available for scheduling purposes, the resource must be associated with a Shift.

Shifts are used to define the available capacity of a resource. Shifts contain different
activity types to identify working time from non-working time and downtime. A shift may
contain multiple activity types. The default activity types included in the application are:

• Working time
• Non-working time
• Lunch time
• Maintenance time
• Approved overtime

Shift changes can be applied to the entire factory, single or multiple resources to account
for changes to the default shift pattern.

Defining your Working Hours
The following steps describe how to create new activities.

Activities are used to define your working an non-working hours.

Hi Colin,

The company will be on shutdown for the last 2 weeks in December. I cannot see that we have an activity
defined for this purpose. Please action at your earliest convenience.

Thanks

1. Select the Home Menu.

2. Select Activities.

3. Select Add New.

4. Enter Shutdown in the Activity Code field.

5. Enter Christmas Shutdown in the Activity Description field.

6. Select a Color for the activity by Selecting […]

7. Select OK.

8. Select OK.

9. Select OK

Adding a shift
The following steps describe how to create a new shift based on hour types.
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Hi Colin,

The company will be operating on a 6-day week (Mon-Sat) from 8AM to 8PM with 1 hour for lunch between
12PM and 1PM. We require a new shift to be created that can handle this. Please action at your earliest
convenience.

Thanks

1. Select the Home Menu.

2. Select Shifts.

3. Select Add New.

4. Enter Mon-Sat 8-8 in the Shift Name field.

5. Enter Mon-Sat 8-8 in the Shift Description field.

6. Under the timeline for Monday, left Select and drag to highlight the time from 08:00
to 12:00 -Times can also be edited by overtyping the Start and End Time in the pop
up.

7. Select the StdWorking Activity Code.

8. Under the timeline for Monday, left Select and drag to highlight the time from 12:00
to 13:00.

9. Select Apply.

10. Select the StdLunch Activity Code.

11. Select Apply.

12. Under the timeline for Monday, left Select and drag to highlight the time from 13:00
to 20:00.

13. Select the StdWorking Activity Code.

14. Select Apply

Note: You can either repeat steps 7-15 for Tuesday to Saturday or use the
copy function

15. Select and hold the Copy Shift Pattern for Monday.

16. Drop the shift down to Tuesday.

17. Repeat for Wed through to Saturday.

18. Select OK.

19. Select OK.

Adding an activity
The following steps describe how to create a multi-shift environment.

Over the next few tasks you will setup a Multi-shift environment e.g. 2 x 8 hour shifts
with 1 hour break.

Hi Colin,

The company has agreed to extend its operating hours to 2 x 8-hour shifts, Monday to Friday, each with a
1-hour break. We require a new shift to be created that can handle this. Please action at your earliest
convenience.

Thanks
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1. Select the Home Menu.

2. Select Activities
3. Select Add New.

4. Enter Day Shift in the Activity Code field.

5. Enter Day Shift in the Activity Description field.

6. Tick Working.

7. Select a Color for the activity using […]

8. Select OK.

9. Select OK.

10. Repeat steps 3-9 to create a new activity for Night Shift.
11. Select Add New.

12. Enter Break in the Activity Code field.

13. Enter Break in the Activity Description field.

14. Leave Working and Downtime unchecked.

15. Select a Color for the activity using […]

16. Select OK.

17. Select OK.

18. Select OK.

Adding a new shift
The following steps describe how to create a new shift.

1. Select the Home Menu.

2. Select Shifts.

3. Select Add New.

4. Enter Double Shift in the Shift Name field.

5. Enter Double Shift in the Shift Description field.

6. Under the timeline for Monday, left Select and drag to highlight the time from 06:00
to 09:30 - Times can also be edited by overtyping the Start and End Time in the
pop up.

7. Select the Day Shift Activity Code.

8. Select Apply.

9. Under the timeline for Monday, left Select and drag to highlight the time from 09:30
to 10:30.

10. Select the Break Activity Code.

11. Select Apply.

12. Under the timeline for Monday, left Select and drag to highlight the time from 10:30
to 14:00.

13. Select the Day Shift Activity Code.

14. Select Apply.

15. Under the timeline for Monday, left Select and drag to highlight the time from 14:00
to 17:30.

16. Select the Night Shift Activity Code.
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17. Select Apply.

18. Under the timeline for Monday, left Select and drag to highlight the time from 17:30
to 18:30.

19. Select the Break Activity Code.

20. Select Apply.

21. Under the timeline for Monday, left Select and drag to highlight the time from 18:30
to 22:00.

22. Select the Night Shift Activity Code.

23. Select Apply.

24. Select and hold the Copy Shift Pattern for Monday.

25. Drop the shift down to Tuesday 26. Repeat for Wed through to Friday.

26. Select OK.

27. Select OK.

Assigning a shift to a resource
The following steps describe how to assign a shift to a resource.

You need to assign a shift to a resource so that you can define the resource capacity.

Hi Colin,

The shift applied to MBBA01 is currently showing as the default shift. The correct shift for this machine is
Mon-Sat 8-8. Please action at your earliest convenience.

Thanks

1. Select the Home Menu.

2. Select Machines.

3. Expand the MBBA Work Center.

4. Select the MBBA01 machine.

5. Set the Shift to Mon-Sat 8-8 Using the dropdown.

6. Select OK.

7. Select Nothing.

Changing a resource
The following steps describe how to change a resource.

Hi Colin,

On 2 January we will have in an increased number of resources (10) for ASSEMB. These resources need
to be available for scheduling purposes. Please action at your earliest convenience.

Thanks

1. Navigate to the Factory Explorer.
2. Navigate to the ASSEMB Work Center.

3. Tick ASSE01 to see the machine on the Planning Board.

4. Navigate to 2 January on the Planning Board.
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5. Double Select on the shift for 2 January.

6. Select Details
7. Enter 10 in Resource Qty field for each of the StdWorking Activity Code time

frames.

8. Select on OK.

Viewing a list of shifts
The following steps describe how to view, print and export a list of shifts.

1. Select Home Menu.

2. Select Shifts.

3. To Export - Right Select on any Heading and Select Export.

4. To Print - Print from Export.

5. To View - Select on the Shift and Select Edit Shift

Changing a shift
The following steps describe how to update an existing shift.

Hi Colin,

We would like to adjust the Mon-Sat 8-8 shift so the company finishes early on a Friday.The shift on a Friday
should end at 5PM. Please action at your earliest convenience.

Thanks

1. Select the Home Menu.

2. Select Shifts.

3. Select the Mon-Sat 8-8 shift.

4. Select Edit Shifts.

5. Under the timeline for Friday, left Select and drag to highlight the time from 20:00
to 17:00.

6. Select OK.

7. Select on OK.

Rebuilding a machine shift
The following steps describe how to rebuild a shift for a machine.

In the previous task you updated a shift for a specific day. If the shift has already been
applied to a machine, the machine must be rebuilt for the changes to take effect

1. Select Home Menu.

2. Select Machines.

3. Select Machine View.

4. Locate MBBA01 machine.

5. Select Rebuild in the machine row.

6. Select OK.

7. Select Nothing.
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Updating a shift for a single resource
The following steps describe how to update a shift for a single resource (day, week,
month, year).

Hi Colin,

We would like to plan for our annual shutdown which will occur between the 18th December and the 1
January for MBBA01. MBBA01 is currently operating with the Mon-Sat 8-8 shift and will need to be updated
to take into consideration the shutdown period. There is already a shutdown activity for this purpose. Please
action at your earliest convenience.

Thanks

1. Navigate to the Factory Explorer.
2. Expand the MBBA Work Center.

3. Locate the MBBA01 machine.

4. Right click on MBBA01.

5. Select Shift (Change).
6. Select Add New.

7. Enter Shutdown in the Shift change code field.

8. Under the timeline for left click and drag to highlight the time from 00:00 to 00:00.

9. Set the Activity Code to Shutdown - Christmas Shutdown.

10. Select Apply.

11. Select OK.

12. Click on the heading Ungrouped from the Day Shift Changes task panel.

13. Right click on Shutdown.

14. Select Copy.

15. Select the dates 18 December to 1 January by click and hold of left mouse button.

16. Right click on 1 January.

17. Select Paste.

18. Select Apply.

19. Select YES to rebuild the calendar.

20. Select Nothing.

Note: To remove the rule, right click on the day(s) in the calendar view and
click Set to default.

Updating a shift for multiple resources
The following steps describe how to update a shift for multiple resources.

Hi Colin,

We would like to plan for an annual shutdown which will occur between the 18th December and the 1 January
for Bicycle Wheel Assembly MBWA. MBWA is currently operating with the default shift and will need to be
updated to take into consideration the shutdown period. Please action at your earliest convenience.

Thanks
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1. Select the Home Menu.

2. Click on Changes.

3. In the Company Panel, tick MBWA (confirm only the MBWA machines are selected).

4. Click on the heading Ungrouped from the Day Shift Changes task panel.

5. Right click on Shutdown.

6. Select Copy
7. Select the dates 18 December to 1 January by click and hold of left mouse button.

8. Right click on 1 January.

9. Select Paste.

10. Select OK
11. Select Apply.

12. Select YES to rebuild the calendar.

13. Select Nothing.

Assessment: Shifts

1. What are working, non-working and downtime hour types?

A. Shifts

B. Activities

C. Mapping

D. Resources

2. Why are shifts required?

A. To define the available capacity of a Machine

B. To define the available capacity of an Employee

C. To define available capacity of a Resource

D. Shifts are not required

3. Shifts contain different activity types to identify working time from non-working time
and downtime.

A. True

B. False
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4. Shift changes can be made to

A. Single Resource

B. Multiple Resources

C. Entire Factory

D. All the above

5.
Hi Colin,

Some MBFA & MBQA Work Centers will be working overtime Monday to Friday from September 1 to
December 18.

We will need a shift defined as follows:

• 08:00 to 12:00 Working Time
• 12:00: 13:00 Lunch Time
• 13:00 to 17:00 Working Time
• 17:00 to 20:00 Overtime
• 20:00 to 21:00 Maintenance Time
• The entire Factory will also be shut down on Nov 22 for Thanksgiving.

Please action at your earliest convenience.

Thanks

Terminals

In the previous lesson you learned how to create and assign shifts to resources.

Terminals are a feature in Workforce Manager that determine the functions that are
available to a user for data collection and reporting purposes. The terminal definition
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represents a collection of predefined Workbench Elements which can be easily added
or removed to suit the functions of your employees. Terminals are highly customizable
and a flexible feature of the application.

In this lesson you will learn how to create 2 types of terminal:

• Clock-In Terminal
• Shop Floor Terminal

Clock-In Terminals are typically located at the entrance of the building or production unit
to track employees clock in and clock out time. This type of terminal may be used by all
employees regardless of their functional role. Clock-In Terminals are typically limited in
their functionality. Shop Floor terminals are typically located on the shop floor and situated
within the relevant production unit. These terminals can be configured by equipment,
crew or employee to display scheduled/unscheduled jobs or only jobs within a specific
time frame or within custom filter definitions. Additional elements can be included, (e.g.
Break, Lunch, Material Issue, Kit Issue, Production Issues) providing employees with
the ability to complete all their reporting requirements from one simple screen.

Terminals can be password protected and multiple users can access the same terminal
from multiple locations.

Manufacturing Operations Management is shipped with 8 pre-configured Workbench
Terminal definitions ready for immediate use. The configuration of these terminals has
been designed to service well established manufacturing models and you can start to
use them as a template with minimal further configuration.

Pre-configured Workbench Terminals

DescriptionTerminal Name

Clock in and out to start/end your data1 - Entrance

Basic terminal with limited options2 - Basic

Advanced terminal with extended functionality3 - Advanced

Advanced terminal with crew functionality4 - Crew

Time entry terminal for employees using timesheets5 - Time Entry

Equipment terminal with downtime tracking6 - Equipment

Advanced terminal with materials issue capabilities7 - Materials

Office terminal for non-manufacturing personnel8 - Office

Adding a terminal
The following steps describe how to create a clock-in terminal.

Hi Colin,

The company requires a new clocking in/out terminal to be situated at the entrance of the building. The
terminal will be presented on a tablet device and should be used by all employees setup in MOM.

Please action at your earliest convenience.

Thanks

1. Select the Workforce Menu.

2. Select Terminal Maintenance.
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3. Tick 1 - Entrance.

4. Select Copy.

5. Enter Outdoors Entrance in the Terminal Name field.

6. Select Save.

Viewing a list of terminals
The following steps describe how to view a list of terminals.

1. Select the Workforce Menu.

2. Select Terminal Maintenance.

3. Confirm required terminals have been setup.

4. SelectExport (if required).

Configuring your Terminal (Quick)

Terminal elements can be configured, added or removed to suite the functionality of the
terminal. For instance, some elements could be required in one terminal but not in
another. For example, the Kit issue and Material Issue functions may be relevant to a
group of employees in production areas such as picking but not in assembly.

Terminals can be linked to one or multiple equipment records, this enables the
employees, when opening the Workbench, to view the schedules put together by the
Planner. Data collection is gathered, if enabled, by linking one or multiple equipment to
a Terminal.

Terminals can also be configured to filter only relevant data to that terminal.

Configuring your Terminal (Advanced)

Advanced Settings are used to define how the application collects and processes
manufacturing data. These are important and complex settings whose configuration
requires an in depth understanding of the both the application and the organization. Do
not edit these settings unless you fully understand the ramifications of the changes you
may make. Inaccurate setup may cause the application to capture data incorrectly or
interpret data collection unreliably.

Advanced Settings - Summarized

PurposeSub TabTab Name

Used to define and configure data
entry terminals across your

TerminalsWorkbench

business and shop floor. Control
access using passwords. Create
dynamic views of data depending
on the employee accessing the
terminal.

Used to track an employee's or
equipment's status at a point in

Statuses

time. The application is shipped
with a number of pre-defined status
codes.
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Advanced Settings - Summarized

PurposeSub TabTab Name

Used by the Workbench to control
the different types of functions
available to the user.

Elements

Every On-Screen Element (button)
on the Workbench has a set of
functions assigned to it. Functions
are used to pre-define the button's
behavior and processes that will be
executed in the background by
pressing that button

Used to determine the relation
between statuses and On-Screen

Matrix

elements so the application knows
which On-Screen elements to show
or execute on the Workbench
screen in regards to status of the
employee/equipment.

Used to define the columns and
their sequence for certain types of
grid layout screens.

Grid SettingsDesigner

Note: Workbench grid
settings are defined in the
Workbench onscreen
elements \ function settings.

Used to control the column width
and sort order of certain screens.

Column Width

Used to control the column width
and sort order of workbench.

Column Width (Workbench)

Used to define and manage the
measurement, schedule, recipient

AlertsAnalytics

information, notification method and
message template for default
management alerts.

Throughout Manufacturing
Operations Management there are

Dial/Bar KPI's

many visual presentations of
performance, availability, quality
etc.These act as a quick visual key
performance indicator for the
organization and can be
customized to display different
colors based on pre-defined
threshold values. Dial and Bar KPI's
are seen in areas such as the
Workbench, Reports and
Dashboards.

Used to define types of issue codes
for reporting and analytical

IssuesDefinitions

purposes. The application is
shipped with a number of issue
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Advanced Settings - Summarized

PurposeSub TabTab Name

codes by default. Additional codes
can be added where required.

Used to define types of custom
codes for reporting and analytical

Custom

purposes. The application is
shipped custom codes by default.
Additional codes can be added
where required.

Used to define additional reporting
details for analytical purposes. The

Dropdown

application is shipped with the
following dropdown codes by
default. Additional codes can be
added where required.

Used to define which additional
tracking fields are required for
reporting or analytical purposes.

Extended

Used to create predefined
classification values for reporting

Classifications

and analytical purposes. The
application is shipped with the
following classification codes by
default and are provided as a guide.
Classification values can be
updated to suit the company's
reporting requirements.

Used to control which columns are
displayed in relation to stock code

Data

and job, operations, jobs, jobs with
drill down to operation.

Used to categorize time in the
context of job or activity subject.

Tasks

Tasks can be created to suit the
company's requirements.

Used to edit, delete and create
default filtering periods for the
application.

Periods

Used to categorize time by cost
type and operational type. New

Diversions

diversions can be created to suit
the company's requirements.

Used to create, edit and delete
fixed or recurring schedule times.

Scheduler

Schedules are used to automate
the execution of on-screen
elements. For example, sending
employees to break, lunch etc.The
application is shipped with default
schedules

Used to manage user or
companywide quick links that

Bookmarks

appear on the applications home
page. With the exception of the
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Advanced Settings - Summarized

PurposeSub TabTab Name

Workbench, Users can add
Bookmarks manually by clicking on
the Bookmark option from any
application page.

Used to configure the layout and
default values provided in
Timesheets.

N/ATimesheet

Used to manage global transaction
permissions. From this screen you

N/APermissions

can determine whether transactions
can be edited or deleted.

Used to manage the default
approval status of generated

N/ARules

transactions. The application is
shipped with default rules.

Used to manage default application
settings in relation to data

N/A
General

collection, display of decimals,
group security and data
management. The application is
shipped with default settings.

Used to backup all settings of the
current configuration. When saved

N/A
Profiles

to the database, the profile can be
exported to file.

Note: This guide does not provide scenarios for all advanced settings but instead
provides examples of the top 10 configurations requested during implementation.

Assessment:Terminals

1. Which field on the Create Terminal screen controls which equipment is available
from the Workbench?

A. Linked equipment

B. Default Equipment

C. Equipment Terminal

D. Access Control

2. Additional Terminals can be added by copying an existing Terminal.

A. True

B. False
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3. Which 2 methods could be used to restrict which stock codes are visible to the
terminal users?

A. Apply access control

B. Edit Add Tasks on Screen element

C. Apply a Terminal data filter

D. Set Default equipment

4. How are you able to control which users can access a terminal?

A. Declare linked equipment

B. Apply data filters

C. Enable access control

D. Assign crew

5.
Hi Colin

We require a new terminal for the Bicycle Brake Assembly Work Center.

The terminal should be configured for the equipment codes MBBA01, MBBA02 and MBBA03.

Employees will require all elements of advanced terminal except for the Add Tasks Element.

Please action at your earliest convenience.

Thanks
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Schedule and Publish - Processing

Using SYSPRO MOM

We have already learned that SYSPRO Manufacturing Operations Management has
been formed around the international standard, IEC62264. Other core activities of this
standard include detailed scheduling, dispatching, execution management, data collection
and tracking.

Detailed scheduling deals with optimizing the use of resources to meet production
requirements. Dispatching deals with the flow of production to equipment and personnel
through the use of job lists. Execution management deals with moving work through the
sequence of operations as defined by the routing. Data collection deals with the gathering,
compiling and management of data from production. Tracking deals the summarized
real-time status reporting of personnel and equipment being used to produce a product
including the current operating conditions (as these may affect the schedule).

These activities are referred to in this guide as transaction processing and are covered
in this section.

Advanced Planning and Scheduling

Planning and scheduling is a major challenge for many organizations. The variables
within processes can make or break a company, and unsatisfactory production planning
leads to high operating costs and customer delivery problems.
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MOM incorporates an advanced, finite capacity based, planning and scheduling (APS)
system allowing you to quickly and accurately schedule while minimizing downtime.

Enabling organizations to create accurate schedules that factor in constraints around
tooling, machines, personnel and inventory. Manufacturers are then able to make smarter
use of materials and resources helping them deliver to customers faster and in the most
cost-effective way possible.

Process Flow

Scheduling Basics

Introduction to Visual APS

Factory Explorer Panel

The Factory Explorer Panel provides an outline view of the manufacturing facility by
Work Center and Machine . Each Work Center and Machine has a checkbox to indicate
whether it should be displayed in the Planning Board. They appear to the left of the
board in alphanumeric order.
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You are able to Manage the machines that you see in the Planning board by using
simple techniques below:

• Check the box next to a Machine to view it in the Planning Board. Check the box
next to a Work Center to view all of the associated Machines for that Work Center
in the Planning Board.

• Uncheck the box next to a Machine or Work Center to remove them from the
Planning Board.

• Check or clear the checkbox at the top of the Factory Explorer panel (to the left of
the column headings) to view or remove all Machines from the Planning Board.

Task Panel

The Task Panel displays a list of SYSPRO Production Jobs, Sub Jobs and MRP Jobs.
These are divided into Pockets.

A tab displays the total number of Jobs currently contained in its grid. The Job counter
is dynamic and responds to a data refresh, changes in the setting or filters. Filters may
be applied for any column or columns in the task panel. When a filter is applied, the tab
name shows the number of Jobs followed by the word Filtered in red. It is possible to
have no Jobs showing if the filters are too restrictive and in this case the counter is 0.

The Jobs that appear in the Task Panel will depend on which status codes have been
defined under the Settings > Order Management > Order Imports & Rules.
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You can amend and add your own Criteria. To only display jobs which are incomplete
click on Add under the Status window and Enter incomplete in the Code field. Enter a
description and ensure the check is in All.

Job Panels can be easily turned on/off from the View Menu.

Column Headings

An explanation of some of the most common columns can be seen in the following table.

DescriptionField Name

This provides the ability to add a document related to a Job or an
item. When an Job document is attached, a paperclip icon is
displayed in this column.

Attach

Provides a visual indicator as to whether materials are available
at the start date of the Job.

Materials?

This round colored symbol indicates if there is adequate information
for Visual Planner to schedule the operation or Job.

Operations?

• Green = Valid for scheduling
• Red = Cannot be scheduled
• Yellow = Does not need to be scheduled
• Grey = Needs to be validated (by clicking on the line)

This column is blank if a Job is not scheduled. When scheduled,
the graphic may be:

Scheduled?

• Thumbs up with yellow cuff = scheduled/unsaved
• Thumbs up with green cuff = scheduled / saved
• Warning sign = partial scheduling of some operations
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DescriptionField Name

Provides a visual indicator if the Job has been pinned.This job can
no longer be moved unless the pin is removed first.

Pinned?

Markers appear as user defined visual indicators that can be set
against jobs. Markers can be color coded and used for sorting and
filtering purposes.

Marker

Available capacity at a Work Center may be changed when settings
or shifts are changed. After saving the change, a dialog box appears

Possible Errors

asking if any jobs should be ignored, unscheduled or marked as
possible errors. This column will display a red circle with an x as
the possible error designation. The Jobs or operations should be
verified. To remove this icon, use the Resolve Possible Errors
function.

When imported from ERP system this is the Job/Operation planned
Start Date. This will be updated once the Job/Operation is
scheduled within Visual APS with the actual scheduled start date.

Scheduled Start

When imported from ERP system this is the Job/Operation planned
Due Date.This will be updated once the Job/Operation is scheduled
within Visual APS with the actual scheduled due date.

Scheduled Due

This is based on the original planned scheduled due date. This
date does not change when the job is scheduled.

SYSPRO

The total quantity to produce on the Job.Ordered

How many units have been produced against the Job.Reported

Shows the difference between the ordered quantity and the reported
quantity.

Remaining

A clock Icon will appear in this column if when a Job is scheduled
and updated back to SYSPRO the Job's due date is after the source
due date in SYSPRO.

Running Late?

Columns can be reordered, added or removed depending on your requirements.

How to change the order of Column Headings

To change the order of the columns in the order grid drag a column header to a new
location. The application retains the change and the task panel will again appear in this
order when the software is reopened. Default view settings can be restored from the
Settings dialog, Reset layout settings button.

How to add or remove columns

A number of additional columns are available and can be added to the task panel.
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The following steps explain how to do this.

1. To open the Edit Columns dialog for more column options, right click on a column
header and select Column Settings from the context menu.

2. Locate the Column Header you wish to add or remove. The left side of the Edit
Columns dialog includes the list of all column possibilities in alphabetical order. If
you have located the column to add in this list click the + to transfer it to the Right
side of the Dialog.

3. The right side of the Edit Columns dialog allows you to control your columns. Check
the box to the left of the name to include it in the order grid. Uncheck or clear the
box to remove it.

4. The order of the columns may be changed in three ways:

a. Use the Up and Down arrows in the middle of the Column Picker dialog.
b. Select a new number to the right of the column name using the drop down arrow

then click the arrow next to the number to make the change
c. Drag and drop the column header in a new position on the list.

5. For additional controls, click the arrow above the list of columns headers.

a. To perform a search to find a particular column header, enter the search criteria.
Click the magnifying glass to start the search. Click the magnifying glass again
to go the next match. Check or clear the Search Forward box, depending on
which direction you want to search.

b. Check or clear the Enable Search Indexes box to show or hide the column
indexes.

c. Check the Select all box if you want to show all column headers. Clear the
Select All box to start over.

6. Double-click on a column header to change the name. With the text selected, enter
the new name. Then press Enter to apply the new name.
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Note: The custom name will be placed in brackets after default name of the column
in the list of all available columns (in the left).

Planning Board

The Planning Board Panel displays all scheduling information, including Work Center's
and their time schedules.The start and end date/time for scheduled Jobs are graphically
represented . Vertical lines divide the time bar in various increments. The vertical lines
remain in the same place but represent different amounts of time.

Each Machine that is selected or highlighted in the Factory Explorer panel will appear
on the Planning Board in the form of two horizontal lines (three if you are using the
resource mode).

• The top line indicates the Machine capacity defined by shifts . It displays the
Machine scheduled hours in colored blocks for working / non-working or other
activities.

• The middle line presents resource availability at any point of time.This information
can be presented in %, quantity or colored equalizer modes.

• The bottom line displays scheduled tasks in blocks on a line in the sequence they
are scheduled.The tasks cover the time required for that item to be produced.The
time consumption is calculated according to the route parameters of the Machine
(i.e., item units per hour, number of workers, calendar rules, etc).

Available Resources

You can show available resource representation on the Planning Board as one of the
following:

• Equalizer
• Line diagram
• Numbers
• Percentage

These options are represented by the following icons and views can be amended by
selecting the corresponding image.

Note: This option changes the representation only for Machines with the enabled
resource mode.

How to use Zoom on the Planning Board

Planning Board has zooming functionality which can be used to change the time
interval. Use the + & - icons on the top left-hand corner of the planning board to zoom
in and out or alternatively access the Zoom in and Out functions from the Review menu.

Visual APS also supports zooming in intervals of Minute, Hour, Day and Week.
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Arranging Panels

The panels of the Main Window can be changed according to your preference.You can
do any of the following with the panels of the Main Window:

• Resize
• Float
• Dock
• Tabbed Document
• Autohide

How to Move the Factory Explorer,Task Panel or Planning Board

1. Select and hold the left mouse button on the window header. A colored area indicates
the window you are moving. Small icons indicate the possible locations to move the
window.

2. Drag the window to the new location on the screen. Point to one of the icons to dock
the window to that location. Or drag it anywhere to open that panel in a separate
window (floating).

How to Resize the Factory Explorer,Task Panel or Planning Board

1. Point the mouse on the border of the window until the resizing cursor appears.
2. Click and hold the left mouse button and drag the border as needed.
3. Release the left mouse button.

How to Float the Factory Explorer,Task Panel or Planning Board

1. Click on the small arrow at the top right of the window that you want to float.
2. Select Floating from the menu. The panel is now in a separate window. You can

also simply double-click the window header.
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How to Dock the Factory Explorer,Task Panel or Planning Board

Windows are automatically docked. If you have previously floated a window, you can
redock it by moving it to one of the docked locations indicated by the small icons that
appear when you move a window.

How to Create a Tabbed Document

1. Click on the small arrow at the top right of the window that you want to tab
2. Select Tabbed Document from the menu. The panel is now placed in another

window as a tab.

How to Auto Hide the Factory Explorer,Task Panel or Planning Board windows

1. Select the Auto hide icon on the right side of the window header.
2. The window is hidden on the side it was docked to. Hover over the window name

to see it or click on the name to open it.

Shortcut Keys

Some standard MS-Windows shortcuts are available for use in Visual APS. These are
optional and are primarily used from the Task Panel and other grids.

Program key combinations

(high volume) Select all the items in the current gridCTRL + A

Copy the selected fieldCTRL + C

Refreshes data from SysproCTRL + R

Saves or Updates SysproCTRL + S

RedoCTRL + Y
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Program key combinations

UndoCTRL + Z

Mouse key combinations

Changes the planning board zoom +/-; point to a specific spot to zoom thereCTRL button + mouse
wheel scroll

Uses the Autoshift FunctionALT + drag and drop
scheduling

Move a Task on the Planning Board to the closest limit (e.g. another scheduled
task)

SHIFT + mouse wheel
scroll

Task Panel selection of a group of jobsSHIFT + left mouse

Task Panel selection of specific jobsCTRL + left mouse

Quick Access Toolbar

The quick access Toolbar appears to the left of The Title Bar. This can be moved by
right clicking on the toolbar and selecting Set Below. By default, the Quick Access Tool
includes menus for some of the most common commands for easy access. The default
Command are:

• Save and Publish
• Refresh Data from Database
• Unschedule Selected Items
• Highlight Job
• Load Required WorkCenter
• Unload All WorkCenters
• Perform Autoscheduling
• Show Resource Consumption

Commands can be added or removed from the Quick Access Toolbar. To add a
command Locate on the Ribbon menu, Right Click on the command and select Add
to Quick Access Toolbar.

To remove the command Right Click on the Command in the Quick Access Toolbar
and click Remove From Quick Access Toolbar.

Planning Horizon

The Planning Interval in Visual APS defines the period of time where scheduling can
occur.

You cannot perform scheduling outside the Planning Interval. The planning interval is
defined under the settings area in Visual APS and saved to the user's settings file.

The Planning Interval can also be changed at any time by going to the Schedule menu
and select Interval. By default, this is set to 12 weeks.
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The Planning Horizon is visible in the Title Bar at the top of the Visual APS window
along with the Server Name, Database Name, and Data Loaded.

Forward/Backward Scheduling

There are two primary methods of scheduling: forward, backward.

Forward scheduling takes a job with a number of tasks and allocates those tasks to
resources as early as possible, in other words when resources become available.There
is also an option for Visual APS to schedule forward from a specific day.

Backward scheduling takes a job with a number of tasks and allocates those tasks to
resources in reverse orders, from last to first operation, and schedules the task on the
resource.

Forward scheduling
The following steps describe how to forward schedule.

Hi Colin,

Without making any changes to the current schedule, please forward schedule from today's date, job 534.
Please action at your earliest convenience.

Thanks

1. Right click on Job 534 in the Task Panel.
2. Select Autoschedule.

3. Select on the drop-down arrow at the top of Autoscheduling Dialog window.

4. Select direction Forward.

5. Tick Create Dependency.

6. Select From.

7. Enter today's date in the schedule from/to field

8. SelectSchedule.

9. Select OK.

10. Select OK.

11. From the Quick Access Toolbar select Save & Publish.

12. Select OK.

13. Select Yes.
Job 534 will be forward scheduled to when the required resources are next available.

Backward scheduling
The following steps describe how to backward schedule.
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Hi Colin,

Without making any changes to the current schedule, please backward schedule from the end of next month,
job 538. Please action at your earliest convenience.

Thanks

1. Right click on Job 538 in theTask Panel.
2. Select Autoschedule.

3. Select on the drop-down arrow at the top of Autoscheduling Dialog window.

4. Select direction Backward.

5. Tick Create Dependency.

6. Select From.

7. Enter the end of next month in the schedule from/to field.

8. Select Schedule.

9. Select OK
10. Select OK.

11. From the Quick Access Toolbar select Save & Publish
12. Select Yes.

Job 538 will be backward scheduled from the end of next month and when the
required resources are next available.

Advanced Scheduling

To effectively schedule you need to understand your environment and production process.
Depending on your process your approach to scheduling may be different.

Production LineBatch ProductionJob ShopProcess

Low product mix (high
volume)

Moderate product mix
(moderate volume)

Custom product (low
volume)

Characteristics

LowModerateHighProduct Variety

LowModerateHighEquipment Flexibility

HighModerateLowProduct Volume

See the chart below to match the scheduling techniques to your own environment.

Production LineBatch ProductionJob ShopTechnique

NoYesYesResource Consumption

NoYesYesAlternative Resourcing

YesYesNoC h a n g e o v e r
Minimization

NoYesYesBottleneck Scheduling

NoYesNoAuto Sequencing

YesNoNoHigh Utilization
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Mapping

Simplify scheduling by mapping WIP-MOM resources

After you run the option to Import Machines from the Visual APS menu, an automatic
mapping will be created between the Machine in Work in Progress and the machine
created in Visual APS. In most cases machine mappings do not require any
reconfiguration. However, there may be situations where the company wishes to maintain
a different organizational structure of machines/work Centers within Visual APS.

Mapping Work in Progress to MOM Resources
The following steps describe how to re-map WIP-MOM resources.

Hi Colin,

We currently have 4 machines, MBBA01, MBBA02, MBFA01, MBFA02 located within Work Centers MBBA
and MBFA. The company would prefer to consolidate all 4 machines into machine MBFA01 in the MBFA
Work Center. Please action at your convenience.

Thanks

1. Select Home menu

2. Select Mapping.

3. Select the + sign next to the machine MBFA01.

4. Double click to Place a check mark next to MBBA01, MBBA02, MBFA01 and
MBFA02.

5. Select Nothing.

Note:  After creating the new machine mapping, operations for MBBA01,
MBBA02 and MBFA02 can be scheduled to machine MBFA01. Reverse the
above if you decide to remove the mapping.

Alternative Resourcing

When a specific Machine has no available capacity in the current planning interval,
Visual APS can still schedule a job/operation automatically if there is spare capacity
within other compatible machines.This is done through the use of alternative machines.

Machines that can perform similar operations are associated for this function to work.

There is also the option to over-ride any saved default settings during each
autoscheduling session.This is done by selecting/unselecting "Use Alternative Machines"
from the autoscheduling dialog options.

Creating a machine group
The following steps describe how to create a machine group.

1. Select the Home Menu.

2. Select Alternatives
3. Select Add > New
4. Enter Group1 in a Group Name field.
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Note:  Max 8 Characters

5. Enter ALTGroup1 in the Description field.

6. Select OK.

7. To the left of the group name click the + symbol to display a list of Machines.

8. Tick the box against each Machines that is to be included in the group

9. Select OK

Using alternative machines when scheduling
The following steps describe how to use alternative machines when scheduling.

1. Select the Schedule Menu

2. Select Default.
3. Select Scheduling & Routing Rules.

4. Click on the Manual Tab.

5. Tick Alternative Machines.

6. Select OK.

Using alternative machines
The following steps describe how to use alternative machines.

Hi Colin,

We currently have 3 painting machines PAIN01, PAIN02 and PAIN03. It appears that we are only scheduling
to PAIN01 even though we have capacity on PAIN02 and PAIN03. These machines can perform the same
operation. I believe Visual APS will allow us to schedule to the other machines when there is no capacity on
the primary machine PAIN01. Please action at your convenience.

Thanks

1. Click the Home Menu.

2. Select Alternatives.

3. Select Add New.

4. Enter Paint in the Group Name field.

5. Enter Paint Group in the Group Description field.

6. Select OK.

7. Expand the group Paint by Selecting on the + symbol

8. Select machines PAIN01, PAIN02 and PAIN03.

9. Select OK.

If you use the Alternative Machines function this means that if a Machine is fully
loaded, another Machine in the group will be scheduled but only as a second choice.
The usual Visual APS logic is to try and schedule the Machine specified in the
operation (the primary) and then try and schedule to alternatives in random order.
If an operation can be produced at more than one Machine, there is also the option
to drag and drop it either to the primary Machine specified or to an alternative
Machine in the group. There is the facility to turn off visibility of the Alternative
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Machines during this process by removing the tick from the Loading settings in the
Schedule menu.

Setup multi-resource Work Centers

(e.g. a single scheduling resource with multiple operators or machines)

There may be situations where a single scheduling resource may contain multiple
operators or machines. Instead of managing scheduling resources for each individual
operator or machine, you may choose to manage only one scheduling resource and set
the number of resources appropriately.

Adding multiple operators to a single resource
The following steps describe how to set multiple operators for a single resource.

Hi Colin,

It appears the assembly Work Center ASSEMB is currently set to 1 resource.There are actually 5 resources
in assembly. Please action at your convenience.

Thanks

1. Select the Home Menu.

2. Select Machines.

3. Expand the Work Center ASSEMB by clicking on the + symbol.

4. Select on the ASSE01 machine.

5. Enter 5 in the Resources field.

6. Select OK.

7. Select Nothing.

Varying resources
The following steps describe how to set multiple operators for a single resource.

There may be situations where the number of resources vary throughout the day/week.

Hi Colin,

Apologies for the confusion I have previously mentioned that we have 5 resources in ASSEMB, however
these 5 resources are only available in the morning & 3 in the afternoon.

Please action at your convenience.

Thanks

1. Select the Home Menu.

2. Select Machines.

3. Expand the Work Center ASSEMB by clicking on the + symbol

4. Select on the ASSE01 machine.

5. Select Edit Resources, located on the right side of the screen.

6. Right click over Monday afternoon working activity and change Resource Qty: to
3.
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7. Select Apply.

8. Repeat step 6 for Tuesday, Wednesday, Thursday and Friday.

9. Select OK.

10. Select OK.

11. Select Nothing.

Define and assign your constraints

Global

The Constraints editor in Visual APS defines the system equivalent resource quantities
and the system equivalent resource hours for different types of resources. Constraints
can be set for people, machine and time.

Defining a global constraint
The following steps describe how to set a global constraint.

Hi Colin,

We have been experiencing a few issues with machine MBFA03 in Work Center MBFA and as a result the
machine is running 50% slower than normal.We need to account for this in MOM before we begin to schedule
any more jobs to the MBFA03 machine.

Please action at your convenience.

Thanks

1. Select the Home Menu.

2. Select Constraints.

3. Select Add Constraint.
4. Enter Slow Machine 50% in the Constraint name field and Description field.

5. Select OK.

6. Under Global Multiplication Factors select Edit in the Machine constraint type
row .

7. Enter 1 in the Resource Qty Factor field.

8. Enter 1 in the Setup Time Factor field.

9. Enter 1,5 in the Run Time Factor field.

10. Select OK.

11. Select OK.

12. Select the Home Menu.

13. Select on Machines.

14. Expand the MBFA Work Center.

15. Select on the MBFA03 Machine.

16. Set the Resource Type to Slow Machine 50% using the dropdown.

17. Select OK.

18. Select Nonthing.
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Stock Code

Specific constraints can be set up within any declared global constraint. These stock
code/operation specific time settings replace the values declared in the original routing
and are used within Visual APS in conjunction with the global constraint multiplication
factors. Stock Code constraints are specified in hours.

Defining a stock code constraint
The following steps describe how to set a stock code constraint.

Hi Colin,

The Drilling operation of Stock Code LOT114 if it runs on DRIL01 the run time is correct, 15 minutes, however
DRIL02 is slower the run time is 45 minutes per unit. We do not want to update the Structure and Routing
or any open jobs for this Stock Code in Work in Progress because DRIL02 is an alternative machine. However,
we need to account for this in MOM before scheduling any further jobs.

Please action at your convenience.

Thanks

1. Select the Home Menu.

2. Select Constraints.

3. Select the Machine Constraint.

4. Select Add Constraint.
5. Add a name and a description to the Constraint.

6. On the Global Tab select Edit on Machine Constraint type

7. Add 1 value for Resource Qty Factor, Setup Time Factor and Run Time Factor

8. Select OK.

9. Switch to the Stock Code Operation Description tab.

10. Select Add New.

11. Enter LOT114 in the Stock Code field.

12. Enter Drilling Operation in the Operation Description field.

13. Enter 3 in the Run Machine Time field.

14. Select OK.

15. Select OK.

Secondary Constraints

MOM supports scheduling of an operation in conjunction with multiple secondary
constraint requirements. Secondary constraint serves as a generic purpose and may
represent various limitation factors: tools, jigs, forms, pool of specific employees, etc.
Within a finite capacity scheduling mode, Visual APS will not schedule an operation
within time periods if insufficient secondary constraint capacity exists.

Visual APS Secondary constraint definition consists of 4 parameters:

MeaningDefinition

Defines actual secondary constraint requiredSecondary Constraint
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MeaningDefinition

Defines how may secondary constraint resources
(quantity) is required to perform primary operation

Quantity

Defines which operation portion or combination of
multiple portions require secondary constrain.

Consumption

• Setup time
• Run time
• Teardown time
• Wait time

Defines the method of secondary constraint quantity
consumption.

Consumption Method

• Fixed: fixed quantity of secondary constraint
resources is required disregards of number of
resources consumed by primary operation.

• All: All available quantity of secondary
constraint resources is consumed

• Proportional: Secondary constraint is consumed
proportionally to the consumption of resources
by primary operation.

Example: If a primary operation requires 1 resource (i.e. machine) and 2 resources of
secondary constraint but was scheduled to consume 2 machines, Visual APS will require
4 resources of secondary constraint to be available (proportional increase of resource
requirement by secondary constraint).

Within Work in Progress, a secondary constraint is understood as a Toolset referenced
within the Operational Routing definition.

Routing Definition:

MeaningToolset Field

Indicates secondary constraint requirement here i.e.
JIG_01

Toolset

Indicates number of secondary constraints required
for primary operations

Toolset Quantity

Indicates operational portion where secondary
constraint required. Use one of the below codes

Toolset Consumption

0 - secondary constraint required by All operational
portions

1 - secondary constraint required by Setup portion

2 - secondary constraint required by Production
portions(main and fixed)

3 - secondary constraint required by Teardown portion

4 - secondary constraint required by Wait time portion

5 - secondary constraint required by Production main
portion

6 - secondary constraint required by Production fixed
portion

7 - secondary constraint required by Setup and
Production (main and fixed) portion
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MeaningToolset Field

8 - secondary constraint required by Setup, Production
(main and fixed) and Wait time portion

9 - secondary constraint required by Production (main
and fixed) and Wait time portion

10 - secondary constraint required by Setup,
Production (main and fixed) and Teardown time
portion

11 - secondary constraint required by Production
(main and fixed) and Teardown time portion

12 - secondary constraint required by Production
(main and fixed), Wait and Teardown time portion

13 - secondary constraint required by Wait and
Teardown time portion

Note:  Secondary constraint 'Consumption method' parameter is permanently set
to 'Proportional' method.This is done due to lack of Toolset definable fields in Work
in Progress.

For the cases when a different 'Consumption method' is required, Visual APS should
be customized to read this value from one of the custom form fields.

Scheduling with multiple secondary constraints requirements

There could be cases when multiple secondary constraints are required for the primary
operation: Example 'Tool A' on Setup portion and 'Tool B' on run time portion.

Visual APS does support this within its scheduling algorithms but a customization is
required that add additional ability for multiple secondary constraint definitions within a
single Work in Progress operation. Normally this is done via utilization of Tool Set's
(multiple tools) concept.

Use of secondary constraints in Visual APS

Visual APS treats secondary constrains the same as any other schedulable resource
(Work Center, Machine, Employee, etc.). In order to schedule operations with secondary
constraint, last should be imported into Visual APS with definition of Shift, Resource
Type (machines) and Available resources (number of secondary constraint available)

In order to schedule secondary constraints:

1. Define secondary constraint within SYSPRO BOM Tool Set maintenance
functionality.

2. Indicate secondary constraint requirement within SYSPRO operational Tools Set
definition as specified above

3. Run Visual APS and Import Secondary constraints. These should appear as APS
Factory Explorer elements under 'Tools' Work Center. Refresh APS after secondary
constraint import.
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Note:  As secondary constraint availability is normally not related to working hour's
shifts definition, it is recommended to maintain 24x7 shift for secondary constraint
capacity definition.

Use standard Visual APS Shift Change functionality to indicate periods where Secondary
constraint is not available (planned maintenance, etc.)

Changeover Minimization

Every manufacturing process has periods of time where equipment is unavailable due
to tooling changes, material changes, part changes, program changes, or any other
changes to production that must be performed while equipment is stopped. Collectively,
these events are referred to as "changeovers", "setup" or "planned downtime".

By default, Visual APS schedules all activities within an operation (Setup, Run, Wait
and Teardown). The operation activities are defined in the routing and can be easily
identified in Visual APS.

Labels

Visual APS allows you to change the way jobs are viewed on the planning board. The
labels function provides the ability to view jobs broken down by set up, run, wait and
teardown times within the operation. This is particularly useful when minimizing
changeovers.

Showing labels
The following steps describe how to show labels.

Hi Colin,

We would like to ensure that the planners have visibility of all activities per operation. Currently they are not
seeing the breakdown for setup, run, wait and teardown.

Please action at your earliest convenience.

Thanks

1. Select the View Menu.

2. Select Labels.

Each of the activities within an operation has a default color assigned to it. These
colors can be changed within the Settings Menu.
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Changing the color of tasks in the planning board
The following steps describe how to change the color of tasks in the planning board.

Hi Colin,

The planners would like to easily distinguish setup time from teardown time in the planning board.

Setup time should be red.

Please action at your earliest convenience.

Thanks

1. Select the Schedule tab.

2. Select Default Settings.

3. Select Designer.
4. Select Tasks.

5. Change the Setup color to Red.

6. Select OK.

Bottleneck Scheduling

Bottleneck resources (machine or human) are very common in manufacturing, bottleneck
is any resource whose capacity is less than the demand placed on it.

Under the Manage menu in Visual APS there's a function called List by Operation.
This function allows the Planner to switch Visual APS Task view from a Job level (stock
code to manufacture, quantity to make, job start and end date…) to the Operation level
(Work Center, Machine, setup and run time…). List by Operations offers the Planner
the option to schedule, in first place the bottleneck resource(s) and subsequently the
operations around the bottleneck operation.

Scheduling bottleneck resources
The following steps describe how to schedule bottleneck resources

Hi Colin,

Please schedule bottleneck resource DRIL01 for Jobs 499, 500, 511 and 512.

Thanks
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1. Select on the Manage Menu.

2. Select List by Operation.

3. Drag the column heading Work Center to the top of the Task Panel (drag a column
header here).

4. Drag the column heading Machine to the top of the Task Panel (drag a column
header here).

5. Select the Schedule Menu.

6. Untick the Schedule Around function.

7. Highlight Operation 1 for Job 499, 500, 511 & 512 on the DRIL01 machine.

8. Right Click on one of the highlighted Jobs.

9. Select Autoschedule.

10. Select Schedule.

11. Select OK.

12. Select OK.
At this stage only the operations that runs on the DRIL01 machine is scheduled.

Scheduling the remaining job operations
The followings steps describe how to schedule the remaining job operations.

1. Select the Schedule Menu.

2. Check the Schedule Around function.

3. Highlight Operation 1 for Job 499, 500, 511 & 512 on the DRIL01 machine.

4. Right Select on Operation 1 for Job 499, 500, 511 & 512 on the DRIL01 machine.

5. Select Schedule Around.

Capable to Promise

Visual APS extends the capability of SYSPRO by providing a virtual job scenario. The
Add What If Job option allows you to create a job that is not saved within Syspro so that
you can estimate a production unit's capacity without affecting any of SYSPRO's data.
Once created the What If Job can also be scheduled, it may be determined that a live
manufacturing job should be created. The What If Job can then be unscheduled and
remain on the task panel or it can be deleted.

Adding what-if jobs in Visual APS
The following steps describe how to add a What If Job in Visual APS.

1. From the Schedule menu select Add What IF.

2. Select item number, Routing code, Location, Quantity and Date

3. In description 1 and 2 reference for instance customer name and quote number.
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4. Select OK.

Resource Consumption

Visual APS defines available resources by a combination of the default machine settings
and then by the applied Shift.

Consuming Resources

Resources are consumed based on the requirements defined in your Syspro routing
operations.

To understand how Resource Consumption works in detail it is best to use an example.
Let's consider the following:

A manufacturing operation requires a total of eight (8) hours labor from two (2) resources
to complete.

Float Off

With Float switched OFF, Visual APS will schedule based on 2 resources for 4 hours
elapsed time (2 x 4 = 8 hours total)

In the example below there are MORE resources available (3) than required by the
operation (2). Scheduling is successful.

In the next example there are EQUAL resources to that required by the operation (2).
Scheduling is successful.
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In the final example of FLOAT OFF there are LESS resources (1) to that required by
the operation (2). Scheduling is not permitted.

Float On

Now let's see what happens with the Visual APS float option ENABLED

In the example below there are LESS resources (1) to that required by the operation
(2). However, due to float being enabled, scheduling is now permitted.

In this scenario the 8 hours required are delivered by one (1) resource instead of the
two (2) defined in the operation. Elapsed time is now 8 hours.

In the next example there are MORE resources (4) to that required by the operation (2).
Scheduling is successful.

In this scenario the 8 hours required are delivered by four (4) resources instead of the
two (2) defined in the operation. Elapsed time is now 2 hours.

In the following example resources are VARIABLE and show greater and/or less than
that required by the operation (2). Scheduling is successful.

In this scenario the 8 hours required are delivered when resources are available. Elapsed
time is now 5 hours.
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In the final example of FLOAT ON resources are VARIABLE and show greater and/or
less than that required by the operation (2).

Furthermore, a MAXIMUM setting of two (2) resources has been set, meaning that no
more than 2 resources can be consumed at any one time.

Scheduling is successful.

In this scenario the 8 hours required are delivered when resources are available but
consume no more than 2 resources at any one time. Elapsed time is now 6 hours.

Float Specific

Using Float Discrete, Visual APS is forced to consume resources based on the quantity
to produce. It will not consume more resources than required to produce the quantity.
Consider the following example. It takes one (1) resource, two (2) hours to produce one
(1) unit. Units cannot be produced faster than this.

To produce two (2) units would therefore take four (4) hours).

Note: The Float Discrete setting is a Work Center specific setting and can only be
used when FLOAT SPECIFIC AND float usage is switched ON.

In the example above resources are consumed based on time it takes to produce each
unit. Two (2) units are required to be produced and there are three (3) resources
available. As it takes one (1) resource, two (2) hours to produce each unit, two (2)
resources are consumed for two (2) hours each to produce the two (2) units required.
Scheduling is successful and the elapsed time is 2 hours. Extended this scenario to the
example above you could also produce 3 units in the same elapsed time as you have
3 resources available.

However, four units would take 4 hours of elapsed time (considering available resources
are as in the above example).

Scheduling Jobs

Setting markers
The following steps describe how to set markers.

Creating a new marker
The following steps describe how to create a new markers.
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Hi Colin,

Job 515,516,517 and 520 are critical. Could you please prioritize these jobs to run as soon as possible?

Going forward, jobs marked as critical must receive the highest scheduling priority.

Please action at your earliest convenience.

Thanks

1. Select the Manage menu.

2. Select Markers
3. Select the Marker1 tab

4. Enter Critical in the Value field.

5. Select Add.

6. Click on the circle to the right Critical.
7. Select red from the color palette.

8. Select OK.

9. Select OK.

Updating a job as critical
The following steps describe how to update a job as critical.

1. From the Production Jobs Task Panel select jobs 515, 516, 517 and 5202.

2. Click Select and select Markers.

3. Select Marker1.

4. Select Critical.

Adding filters
The following steps describe how to create filters.

Hi Colin

To assist with scheduling prioritization, we require a filter for the Finished Goods Cycles product classification.
The filter should be distributed to all users of Visual APS. Please action at your earliest convenience.

Thanks

1. Right click on any column Heading in the Production Jobs Task Panel.
2. Select Filter Settings.

3. Select AND.

4. Select Add Criterion field.

5. Select Product Class in the first field.

6. Select Is Equal in the second field.

7. Enter FGC in the value field.

8. Select Save to File.

9. Enter Product Class - FGC in the filename field.

10. Select Save.

11. Select Save to Menu.
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12. Select Add New.

13. Enter Product Class - FGC in the Name field.

14. Select OK.

15. Select OK.

Using groups
The following steps describe how to use groups.

Hi Colin

To assist with scheduling prioritization, it would be beneficial if planners could understand how to group jobs
by different job attributes. (i.e. stock code, customer, project)

Please action at your earliest convenience.

Thanks

1. Select the Production Jobs Task Panel.
2. Drag the column heading Stock Code to the top of the Task Panel (drag a column

header here)

Note: The data will be grouped by Stock Code. Use the + and - icons to the
left of each grouping to expand or collapse the contents of the group. Sub
groups can be added by dragging additional column headings to the top of the
Task Panel. Groups are reset when data is refreshed or when the application
is closed.

Setting calculation method to manual
The following steps describe how to set calculation method tomanual.

1. Click on the Plan menu.

2. Select MRP - Settings.

3. Select the General Tab .

4. Select Manual from the Material Calculation lookup.

Calculating material requirements manually
The following steps describe how to manually calculate material requirements.

Hi Colin,

Prior to scheduling the jobs, the company has prioritized, we need to identify the current position of material
availability. Please action at your earliest convenience.

Thanks

1. Select the Plan Menu.

2. Select Recalculate.

3. Select YES to save the current plan prior to running recalculate.

4. Select Production Jobs Task Panel.
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5. Drag the column heading Material to the top of the Task Panel (drag a column
header here).

Autoschedule jobs by priority index
The following steps describe how to autochedule jobs by priority index.

Hi Colin,

Just following up on those critical jobs.

Could you please sequence the jobs as follow, Job 517, 520, 515 and 516.

Thanks

1. Select all jobs Marked as Critical.
2. Right click and select Autoschedule.

3. Select Schedule by Priority Index.

4. Select job 517 and right click.

5. Select Set Priority > 1.

6. Select job 520 and right click.

7. Select Set Priority > 2.

8. Select job 515 and right click.

9. Select Set Priority > 3.

10. Select job 516 and right click.

11. Select Set Priority > 4.

12. Select Schedule.

13. Select OK.

14. Select OK.

Sequencing jobs using grid grouping
The following steps describe how to autochedule by sequencing jobs by grid grouping.

Hi Colin,

Please schedule all jobs for Product Class FGC where there are no material shortages.

Please action at your earliest convenience.

Thanks

1. Select Workflow. menu

2. Select Product Class - FGC.

3. Select on the down arrow in the Material column heading.

4. From the Materials dropdown select the Green Material Indicator.

5. Select Apply.

6. Right click anywhere in the Task Panel.
7. Select CTRL + A to select all jobs.

8. Right click anywhere in the Task Panel and select Autoschedule.
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9. Select and hold on the Stock Code column heading and drag it to "Drag a column
header here to group by that column" to group jobs by stock code.

10. Group jobs by either: a) Using the Move up and Move Down buttons or b) Left click
and hold and drag the jobs up or down the list.

11. Select Autoschedule.

12. Select Schedule.

13. Select OK.

14. Select OK.

Note: When the Auto Schedule dialog window appears if grouping jobs by
Grid Grouping the first job to be scheduled it will be the one at the top of the
list. If Grouping by Index, then scheduling priority it will be from lowest to highest
number.

Prioritizing by operation
The following steps describe how to prioritize by operation.

Hi Colin

We are frequently seeing a backlog of jobs waiting to be processed on MBQA01, could you please prioritize
scheduling for this machine and other operations to be worked around MBQA01.

Thanks

1. Select Manage menu.

2. Select List by Operation.

3. Filter by Machine name MBQA01.

4. Select Schedule menu and disable Schedule Around?.

5. Two scheduling options: Manually drag and drop one operation at the time to the
Schedule Board or Select group of operations right click and select Autoschedule;
sort operations scheduling priority using Priority Index or Grid Grouping

6. Once operations are prioritized select Schedule.

7. Select OK.

8. Select OK.

9. Select Schedule menu and enable Schedule Around?.

10. From the Task Board select the group operations scheduled (these will be marked
with a yellow thumb up).

11. Right click and select Schedule Around?. This means that those jobs previous
and next operations will now be scheduled providing they can be completed within
the plan interval.

Schedule jobs manually
The following steps describe how to manually schedule jobs.

1. Select job 517.

2. Right click and select Load Required Machine.
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3. Click and hold job 517.

4. Drag it to the Schedule Board.
Visual APS also offers its users the option to schedule by WorkCenter or Machine
this method is frequently used to help minimize tool changes and help eliminate
bottlenecks.

Prioritizing by operation
The following steps describe how to prioritize by operation.

Hi Colin

We are frequently seeing a backlog of jobs waiting to be processed on MBQA01, could you please prioritize
scheduling for this machine and other operations to be worked around MBQA01.

Thanks

1. Select Manage menu.

2. Select List by Operation.

3. Filter by Machine name MBQA01.

4. Select Schedule menu and disable Schedule Around?.

5. Two scheduling options: Manually drag and drop one operation at the time to the
Schedule Board or Select group of operations right click and select Autoschedule;
sort operations scheduling priority using Priority Index or Grid Grouping

6. Once operations are prioritized select Schedule.

7. Select OK.

8. Select OK.

9. Select Schedule menu and enable Schedule Around?.

10. From the Task Board select the group operations scheduled (these will be marked
with a yellow thumb up).

11. Right click and select Schedule Around?. This means that those jobs previous
and next operations will now be scheduled providing they can be completed within
the plan interval.

Reviewing material shortages
The following steps describe how to review material shortages.

Hi Colin,

We need to identify material shortages for FGC stock. I would like to email the procurement team an excel
spreadsheet of the materials we need to purchase for the next 4 weeks.

Please action at your earliest convenience.

Thanks

1. Select the Workflow Menu.

2. Select the Product Class - FGC filter.
3. Click anywhere in the Production Jobs panel and use CTRL + A to select all FGC

jobs.
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4. Select the Plan Menu.

5. Select MRP Views Selected.

6. Set Period Type to Week.

7. Enter 4 in the Periods field.

8. Select Apply.

9. Select Export to Excel.
10. Enter File name and click Save
11. Click Close.

There may be situations where jobs may need to be excluded from the material
calculation to free up materials for other jobs. Let's say there's a job for a large
quantity of 10,000 pieces. Perhaps it is unreleased and you don't believe it will ever
happen. Excluding it will change the material indicator so that it will be excluded
from any calculations.

By default when running recalculate materials, all jobs are included. To exclude a
job after the recalculation has been performed complete the following steps.

Excluding materials
The following steps describe how to exclude materials.

1. Select the Plan Menu.

2. Highlight the job in the Task Panel.
3. Select Exclude.

A job which has previously been excluded can be included by clicking on Include
from the Plan Menu.

Creating a new marker
The following steps describe how to create a new markers.

Hi Colin,

Job 515,516,517 and 520 are critical. Could you please prioritize these jobs to run as soon as possible?

Going forward, jobs marked as critical must receive the highest scheduling priority.

Please action at your earliest convenience.

Thanks

1. Select the Manage menu.

2. Select Markers
3. Select the Marker1 tab

4. Enter Critical in the Value field.

5. Select Add.

6. Click on the circle to the right Critical.
7. Select red from the color palette.

8. Select OK.

9. Select OK.
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Updating jobs with material issues
The following steps describe how to create a new marker.

1. Select the Production Jobs Task Panel.
2. Drag the column heading Stock Code to the top of the Task Panel (drag a column

header here)

3. Use CTRL to Highlight all jobs with some shortages (amber indicator).

4. Right click in Task Pane.

5. Select Markers.

6. Select Marker1.

7. Select Material Issue.

8. Repeat steps 3-7 for all jobs with entire shortages.

9. Click on the down arrow in the Marker column heading.

10. Select Material Issue from the dropdown.

11. Right click on any column heading.

12. Select Export.
13. Enter File Name & Click Save.

Pinning operations to specific machine(s)
The following steps describe how to pin an operation to a specific machine(s).

Hi Colin,

To prevent any further changes to the production schedule, please freeze the schedule for today + 7 days.

Please action at your earliest convenience.

Thanks

1. Select on the Review Menu.

2. Select Pin Advanced.

3. Select Today's date in the date from field.

4. Select Today's date + 7 days in the date to field.

5. Select All Work Centers.

6. 2Select Pin.

Publishing Plans

Changing the planning interval
The following steps describe how to change the planning interval.

The planning interval can be changed at any time.

1. Select Schedule Menu .

2. Select Planning Interval.
3. Select the new interval from the calendar.
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4. Click OK.

Note: The function Save and Publish will post back to Work in Progress the
job's new start and due date. After running Save and Publish, the scheduled
status image will change from a yellow thumbs up to a green thumbs up.

Saving and publishing plans
The following steps describe how to save and publish plans.

Hi Colin,

Please publish the plan so the Jobs are updated in Work in Progress.

Please action at your earliest convenience.

Thanks

1. Locate the Quick Access Toolbar.
2. Select Save & Publish.

3. Select Yes

Note:  If a job is updated in SYSPRO, un-schedule the job in Visual APS then
use the save & publish function again. This returns the job start and due date
to the original SYSPRO start and due dates

Viewing the production plan
The following steps describe how to view the production plan.

1. Select the Reports Menu.

2. Select Production Plan.

3. Click on Select Equipment.
4. Select the required equipment records.

5. Select OK.

6. Select the required date range.

7. Click Refresh.

Printing the production plan
The following steps describe how to print the production plan.

1. Click on the Reports Menu .
2. Select Production Plan from the Published Section.

3. Select Print.
4. Click Select Equipment.
5. Select the required equipment record.

6. Select the required date range.

7. Select Print.
8. Select OK.
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9. Select Refresh.

10. Select the Print Icon.

Viewing your work lists
The following steps describe how to view your work lists.

1. Select the Reports Menu.

2. Select Equipment Job List.
3. Select MBFA
4. Select MBFA01.

5. Select the required date range.

6. Select Refresh

Configuring period filters
The following steps describe how to configure period filters.

Earlier the plan was pinned for the next 7 days.

The workbench can also be configured to reflect the same period and the Add Task
function removed. This will ensure operators are only working on jobs that you have
scheduled in the period you have pinned.

To amend the Workbench configuration:

1. Select Advanced Settings.

2. Select Workbench.

3. Select Elements.

4. Enter workbench in the Code filter field.

5. Double click on the Workbench (Employee) on screen element.

6. Select Settings.

7. Select +7 Days in the use period to filter field.

8. Select Save.

9. Select Close.

10. Select Save.

11. Repeat the steps 1 - 10 for all other workbench onscreen elements.

Removing add tasks onscreen elements.
The following tasks describe how to remove add tasks onscreen elements.

1. Select Advanced Settings.

2. Select Workbench.

3. Select Elements.

4. Enter add task in the Code filter field.

5. Double click on the Add Tasks (Small) on screen element.

6. Select Terminals.

7. Unselect all Terminals.

8. Select Save.
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9. Repeat the steps 1 - 8 for all other add task onscreen elements.

Calculation of potentially late operations
The followings steps describe the calculation of potentially late operations.

The following steps should be taken to carry out this task:

1. Select the Manage Menu.

2. From the Potentially Late options, click on Calculate.

3. Observe which operations have been flagged as potentially late (these are highlighted
in blue on the list and have a blue vertical band to the left of the operation in the
Planning board).

Reschedule late jobs/operations
The following steps describe how to reschedule late jobs/operations including those
highlighted as potentially late.

1. From the Potentially Late options in the Manage Menu select Reschedule.

Note that all jobs/operations highlighted during the calculation process have now
been virtually rescheduled.

Any manual adjustments can be made to the rescheduling proposal at this point.

2. Once complete, select Save and Publish to apply the changes.

Note:  After making changes to the plan, be sure to save and publish the plan
to commit any changes to the Work in Progress and MOM
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Collect and Track - Configuration

Terminals

In the previous lesson you learned how to create and assign shifts to resources.

Terminals are a feature in Workforce Manager that determine the functions that are
available to a user for data collection and reporting purposes. The terminal definition
represents a collection of predefined Workbench Elements which can be easily added
or removed to suit the functions of your employees. Terminals are highly customizable
and a flexible feature of the application.

In this lesson you will learn how to create 2 types of terminal:

• Clock-In Terminal
• Shop Floor Terminal

Clock-In Terminals are typically located at the entrance of the building or production unit
to track employees clock in and clock out time. This type of terminal may be used by all
employees regardless of their functional role. Clock-In Terminals are typically limited in
their functionality. Shop Floor terminals are typically located on the shop floor and situated
within the relevant production unit. These terminals can be configured by equipment,
crew or employee to display scheduled/unscheduled jobs or only jobs within a specific
time frame or within custom filter definitions. Additional elements can be included, (e.g.
Break, Lunch, Material Issue, Kit Issue, Production Issues) providing employees with
the ability to complete all their reporting requirements from one simple screen.

Terminals can be password protected and multiple users can access the same terminal
from multiple locations.

Manufacturing Operations Management is shipped with 8 pre-configured Workbench
Terminal definitions ready for immediate use. The configuration of these terminals has
been designed to service well established manufacturing models and you can start to
use them as a template with minimal further configuration.

Pre-configured Workbench Terminals

DescriptionTerminal Name

Clock in and out to start/end your data1 - Entrance

Basic terminal with limited options2 - Basic

Advanced terminal with extended functionality3 - Advanced

Advanced terminal with crew functionality4 - Crew

Time entry terminal for employees using timesheets5 - Time Entry

Equipment terminal with downtime tracking6 - Equipment

Advanced terminal with materials issue capabilities7 - Materials

Office terminal for non-manufacturing personnel8 - Office
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Creating a new clock-in terminal
The following steps describe how to create a clock-in terminal

Hi Colin

The company requires a new clocking in/out terminal to be situated at the entrance of the building. The
terminal will be presented on a tablet device and should be used by all employees setup in MOM.

Please action at your earliest convenience.

Thanks

1. Select the Workforce Menu.

2. Select Terminal Maintenance.

3. Tick 1 - Entrance.

4. Select Copy.
Enter Outdoors Entrance in the Terminal Name field.

5. SelectSave.

Creating a shop floor terminal
The following steps describe how to create a shop floor terminal.

Hi Colin,

The company requires a new shop floor terminal to be situated in the bicycle assembly Work Center. The
terminal will be presented on a tablet device and should display the same functionality as the template '3 -
Advanced'. The terminal should be configured for MBFA01, MBFA02. We may add additional equipment at
a later date.

Please action at your earliest convenience.

Thanks

1. Select the Workforce Menu.

2. Select Terminal Maintenance.

3. Tick 3 - Advanced.

4. Select Copy.

5. Enter Assembly in the Terminal Name field.

6. Select […] in the Linked Equipment field.

7. Click on MBFA/MBFA01, MBFA/MBFA02.

8. Select OK.

9. Select Save.

Testing your new terminal from the workbench
The following steps describe how to test your new terminal from the workbench.
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1. Select the Workforce Menu.

2. Select Workbench.

3. Select Terminals.

4. Tick Outdoors - Entrance.

5. Enter 110 in the ID field.

6. Select Login.

7. Select Terminals.

8. Select Assembly.

9. Enter 110 in the ID field.

10. Select Login.

Viewing a list of terminals
The following steps describe how to view a list of terminals.

1. Select the Workforce Menu.

2. Select Terminal Maintenance.

3. Confirm required terminals have been setup.

4. SelectExport (if required).

Configuring your Terminal (Quick)

Terminal elements can be configured, added or removed to suite the functionality of the
terminal. For instance, some elements could be required in one terminal but not in
another. For example, the Kit issue and Material Issue functions may be relevant to a
group of employees in production areas such as picking but not in assembly.

Terminals can be linked to one or multiple equipment records, this enables the
employees, when opening the Workbench, to view the schedules put together by the
Planner. Data collection is gathered, if enabled, by linking one or multiple equipment to
a Terminal.

Terminals can also be configured to filter only relevant data to that terminal.

Designing your terminal
The following steps describe how to design your terminal (add/remove buttons and
elements.

Hi Colin,

The assembly terminal is displaying a button for Barcode Entry. This button is not required in the assembly
Work Center and should be removed from the terminal configuration.

Please action at your earliest convenience.

Thanks
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1. Select the Workforce Menu.

2. Select Terminal Maintenance.

3. Tick Assembly.

4. Select Edit.

Within the On-Screen Elements section, deselect the elements:

Barcode Task Entry (Large)

Barcode Task(s) Entry (Large)

5. Select Save.

Linking equipment to your terminal
The following steps describe how to link equipment to your terminal.

Hi Colin

The assembly terminal should be updated to display additional equipment MBFA03 and MBFA04.

Please action at your earliest convenience.

Thanks

1. Select Workforce Menu.

2. Select Terminal Maintenance .
3. Tick Assembly.

4. Select Edit.
5. Select […] in the Linked Equipment field.

6. Select Edit.
7. Select MBFA/MBFA03 and MBFA/MBFA04.

8. Select OK..
9. Select Save.

Controlling access to your terminal
The following steps describe how to control access to your terminal.

Hi Colin

The assembly terminal should be restricted to members of the Workers [1] group. Currently the terminal is
configured for unrestricted access.

Please action at your earliest convenience.

Thanks

1. Select the Workforce Menu.

2. Select Terminal Maintenance.
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3. Tick Assembly.

4. Select Edit.
5. Under User Access, select Access Control.
6. Select […] in the Access Control field.

7. Expand Manufacturing.

8. Expand Production.

9. Expand Line 1.

10. Expand Supervisor [1].
11. Select Workers [1].
12. Select OK.

13. Select Save.

Filter data for your terminal using static and dynamic
filters

Data Filters in Terminal Maintenance are used to filter the data that is displayed to users
of the Workbench. Two types of filters are available

• Static
• Dynamic

Static filters provide you with the ability to filter data based on a fixed value. Multiple
conditions are supported.

Condition Examples

Column NameFilter ValueCondition

ItemB100Item equals B100

ItemB100; B200Item equals B100 or B200

ItemB100Item equals B100 and Operation
equals 10

Operation10

ItemB100Item equals B100 and Operation
does not equal 10

Operation!10

Item!B100; B110Item does not equal B100 or
B110

Dynamic filters provide you with the ability to use current context filters to filter data. For
example, you want to filter tasks where the operation Work Center code is the same as
the employee's home Work Center.

Restricting a terminal to a stock code
The following steps describe how to restrict a terminal to a stock code.

Hi Colin,
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The assembly terminal should be restricted to only display tasks for stock code B100. Currently the terminal
is configured to show tasks for all stock codes.

Please action at your earliest convenience.

Thanks

1. Select the Workforce Menu.

2. Select Terminal Maintenance.

3. Tick Assembly.

4. Select Edit.
5. Select […] in the Data Filters field.

6. Within the options window, enter B100 in the Stock Code field.

7. Select OK.

8. Select Save.

Configuring your Terminal (Advanced)

Advanced Settings are used to define how the application collects and processes
manufacturing data. These are important and complex settings whose configuration
requires an in depth understanding of the both the application and the organization. Do
not edit these settings unless you fully understand the ramifications of the changes you
may make. Inaccurate setup may cause the application to capture data incorrectly or
interpret data collection unreliably.

Advanced Settings - Summarized

PurposeSub TabTab Name

Used to define and configure data
entry terminals across your

TerminalsWorkbench

business and shop floor. Control
access using passwords. Create
dynamic views of data depending
on the employee accessing the
terminal.

Used to track an employee's or
equipment's status at a point in

Statuses

time. The application is shipped
with a number of pre-defined status
codes.

Used by the Workbench to control
the different types of functions
available to the user.

Elements

Every On-Screen Element (button)
on the Workbench has a set of
functions assigned to it. Functions
are used to pre-define the button's
behavior and processes that will be
executed in the background by
pressing that button
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Advanced Settings - Summarized

PurposeSub TabTab Name

Used to determine the relation
between statuses and On-Screen

Matrix

elements so the application knows
which On-Screen elements to show
or execute on the Workbench
screen in regards to status of the
employee/equipment.

Used to define the columns and
their sequence for certain types of
grid layout screens.

Grid SettingsDesigner

Note: Workbench grid
settings are defined in the
Workbench onscreen
elements \ function settings.

Used to control the column width
and sort order of certain screens.

Column Width

Used to control the column width
and sort order of workbench.

Column Width (Workbench)

Used to define and manage the
measurement, schedule, recipient

AlertsAnalytics

information, notification method and
message template for default
management alerts.

Throughout Manufacturing
Operations Management there are

Dial/Bar KPI's

many visual presentations of
performance, availability, quality
etc.These act as a quick visual key
performance indicator for the
organization and can be
customized to display different
colors based on pre-defined
threshold values. Dial and Bar KPI's
are seen in areas such as the
Workbench, Reports and
Dashboards.

Used to define types of issue codes
for reporting and analytical

IssuesDefinitions

purposes. The application is
shipped with a number of issue
codes by default. Additional codes
can be added where required.

Used to define types of custom
codes for reporting and analytical

Custom

purposes. The application is
shipped custom codes by default.
Additional codes can be added
where required.

Used to define additional reporting
details for analytical purposes. The

Dropdown

application is shipped with the
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Advanced Settings - Summarized

PurposeSub TabTab Name

following dropdown codes by
default. Additional codes can be
added where required.

Used to define which additional
tracking fields are required for
reporting or analytical purposes.

Extended

Used to create predefined
classification values for reporting

Classifications

and analytical purposes. The
application is shipped with the
following classification codes by
default and are provided as a guide.
Classification values can be
updated to suit the company's
reporting requirements.

Used to control which columns are
displayed in relation to stock code

Data

and job, operations, jobs, jobs with
drill down to operation.

Used to categorize time in the
context of job or activity subject.

Tasks

Tasks can be created to suit the
company's requirements.

Used to edit, delete and create
default filtering periods for the
application.

Periods

Used to categorize time by cost
type and operational type. New

Diversions

diversions can be created to suit
the company's requirements.

Used to create, edit and delete
fixed or recurring schedule times.

Scheduler

Schedules are used to automate
the execution of on-screen
elements. For example, sending
employees to break, lunch etc.The
application is shipped with default
schedules

Used to manage user or
companywide quick links that

Bookmarks

appear on the applications home
page. With the exception of the
Workbench, Users can add
Bookmarks manually by clicking on
the Bookmark option from any
application page.

Used to configure the layout and
default values provided in
Timesheets.

N/ATimesheet

Used to manage global transaction
permissions. From this screen you

N/APermissions

can determine whether transactions
can be edited or deleted.
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Advanced Settings - Summarized

PurposeSub TabTab Name

Used to manage the default
approval status of generated

N/ARules

transactions. The application is
shipped with default rules.

Used to manage default application
settings in relation to data

N/A
General

collection, display of decimals,
group security and data
management. The application is
shipped with default settings.

Used to backup all settings of the
current configuration. When saved

N/A
Profiles

to the database, the profile can be
exported to file.

Note: This guide does not provide scenarios for all advanced settings but instead
provides examples of the top 10 configurations requested during implementation.

#1 - Automatically send all or certain Employees to break
at hh:mm

Workforce Manager allows for the configuration of auto scheduled events that are run
in the background. Scheduled events are particularly useful for actions of a repetitive
nature.

Creating a schedule to start break
The following steps decribe how to create a schedule to start break.

Hi Colin,

We would like to remove the need for all employees to manually change their status to 'break'. Considering
all employees are sent to break every day at the same time we would prefer that the application automatically
changed their status to break at 10:00. The break is to last for a duration of 15 minutes.

Please action at your earliest convenience.

Thanks

1. Select Advanced Settings Menu.

2. Select Definitions.

3. Select Scheduler.
4. Select New.

5. Enter Break Start at 10:00 in the Code field.

6. Enter Break Start at 10:00 in the Description field.

7. Select Fixed Schedule Type.

8. Enter 10:00 in the Fixed Time field.
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9. Select days Monday through to Friday.

10. Select Save.

Creating a new on-screen element
The following steps describe how to create a new On-screen element to change the
status to break.

1. Select the Advanced Settings Menu.

2. Select Workbench.

3. Select Elements.
4. Select New.

5. Enter Scheduled Break Start- 10:00 in the Code field.

6. Enter Scheduled Break Start - 10:00 in the Description field.

7. Select Break Start at 10:00 from the Execute by Schedule lookup.

8. Select Save.

9. Under the Functions tab, select New.

10. Select Status Change from the Function lookup.

11. Select Update.

12. Select Settings.

13. Select Break from the Target Status lookup.

14. Select Save.

15. Click on the Statuses Tab.

16. Select status codes Clocked-In, Meeting, Project and Training.

17. Select Save.

Creating a schedule to end break
The following steps describe how to create a schedule to end a break.

1. Select the Advanced Settings Menu.

2. Select Definitions.

3. Select Scheduler.
4. Select New.

5. Enter Break End at 10:15 in the Code field.

6. Enter Break End at 10:15 in the Description field.

7. Select Fixed Schedule Type.

8. Enter 10:15 in the Fixed Time field.

9. Select days Monday through to Friday.

10. Select Save.

Creating a new on-screen element to change status back to previous
The following steps describe how to create a new on-screen element to change the
status to back to previous status.

1. Select the Advanced Settings Menu.

2. Select Workbench.
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3. Select Elements.

4. Select New.

5. Enter Scheduled Break End - 10:15 in the Code field.

6. Enter Scheduled Break End - 10:15 in the Description field.

7. Select Break End at 10:15 from the Execute by Schedule lookup.

8. Select Save.

9. Under the Functions tab, select New.

10. Select Status Change from the function lookup.

11. Select Update.

12. Select Settings.

13. Tick Back to Previous Status.

14. Select Save.

15. Click on the Statuses Tab .

16. Select status codes Break.

17. Select Save.

#2 - Automatically clock off all or certain Employees at
hh:mm

Creating a schedule to clock out
The following steps describe how to create a schedule to clock out employes

Hi Colin,

We would like to remove the need for all employees to manually clock out at the end of the day. Considering
all employees clock out at the same time every day, we would prefer that the application automatically
clocked the employee out at 17:00.

Please action at your earliest convenience.

Thanks

1. Select the Advanced Settings Menu.

2. Select Definitions.

3. Select Scheduler.
4. Select New.

5. Enter Clock Out at 17:00 in the Code field.

6. Enter Clock Out at 17:00 in the Description field.

7. Select Fixed Schedule Type.

8. Enter 17:00 in the Fixed Time field.

9. Select days Monday through to Friday.

10. Select Save.
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Creating a new on-screen element to change status to clocked out
The following steps describe how to create a new on-screen element to change status
to clocked out.

1. Select the Advanced Settings Menu.

2. Select Workbench.

3. Select Elements.

4. Select New.

5. Enter Scheduled Clock Out- 17:00 in the Code field.

6. Enter Scheduled Clock Out- 17:00 in the Description field.

7. Select Clock Out at 17:00 from the Execute by Schedule lookup.

8. Select Save.

9. Under the Functions tab, select New.

10. Select Status Change from the function lookup.

11. Select Update.

12. Select Settings.

13. Select Out/Off from the Target Status lookup.

14. Select OK.

15. Select on the Statuses Tab.

16. Select status codes Clocked-In, Meeting, Project and Training.

17. Select OK.

18. Select Save.

#3 - Alert me if an Employee has not clocked off

(i.e. notify me when an employee has been clocked in for longer that X hours)

MOM provides your organization with a number of pre-defined Management Alerts which
can be configured to monitor performance, quality, or availability for either employees
or equipment. Product Users that are assigned as a group owner will automatically
receive Management Alerts for group members (employees or equipment) as defined
in the Organizational Hierarchy.

Creating email alerts
The following steps describe how to create email alerts.

Hi Colin,

We would like to receive an alert when employees in the workers [1] group are clocked in for more than 8
hours.

We have a few employees who forget to clock out and we would like to be notified of this problem. The alert
should be sent via email to the supervisor of the workers [1] group every 30 minutes.

Please action at your earliest convenience.

Thanks

1. Select the Workforce Manager Menu.
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2. Select Alert Maintenance.

3. Double Click on the Time since Clock in Alert.
4. Under the General section, tick Active
5. Under the Analysis section

a) Enter 0.00 in the condition start field.
b) Enter 8.00 in the condition end field.

6. Under the Details section.

a) Select Every 30 minutes from the Execution Schedule lookup.
b) Select […] in the Recipients field.
c) Expand Manufacturing.
d) Expand Production.
e) Expand Line 1.
f) Select the Recipient Supervisor [1].
g) Select Direct from the Group Application lookup.
h) Select OK.
i) Select Save.

Note: The above alerts will be active the next time an employee clocks into
the Workbench and when the clocked in duration is greater than 8 hours. The
alert will continue to email the Supervisor until the employee has clocked out.

#4 - Configure Message button for external mail delivery

Configuring message on-screen element
The following steps describe how to configure a message on-screen element.

Hi Colin,

Please extend the functionality of the message button on the workbench so messages are also delivered to
the recipient by email.

Please action at your earliest convenience.

Thanks

1. Select the Settings Menu.

2. Select the Advanced Settings Menu.

3. Select Workbench.

4. Select Elements.

5. Tick Messages (Small).
6. Select Edit.
7. Click Settings in the sequence 20 row.

8. Tick Send by Email.
9. Select Save.

10. Select Close.
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Configuring SMTP Mail Settings
The following steps describe how to configure SMTP mail settings.

1. Select the Settings Menu.

2. Select Settings.

3. Configure the Email Settings with a valid email account.

4. Select Save.

5. Select OK to restart the site

The email account specified in the SMTP Mail Settings will be used to send email
externally.

Email address for all
Messaging

AddressEmail Settings

From address for all MessagingFrom

Alias address for all MessagingAlias

SMTP Server addressServer

SMTP Port NumberPort

Mailbox accountAccount

Mailbox passwordPassword

SSL required/not requiredEnable SSL

#5 - Changing the default period for displaying scheduled
tasks

The default workbench terminal templates are configured to show scheduled tasks for
+/- 3 days. The default date period against a terminal can be amended to show tasks
using any of the following default periods. In addition, new periods can be created as
required.

DescriptionCode

Today + 14 Days+14 Days

Today + 30 Days+30 Days

Today + 7 Days+7 Days

Today +/- 3 Days+/- 3 Days

TodayToday

Creating a new period
The following steps describe how to create a new period.

Hi Colin,

For all terminals, we would like to change the default task period to +/- 5 days. Currently the terminal is
configured for +/- 3 days.

Please action at your earliest convenience.

Thanks
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1. Select the Advanced Settings Menu.

2. Select Definitions.

3. Select Periods.

4. Select New.

5. Enter +/- 5 days in the Code field.

6. Enter +/- 5 days in the Description field.

7. Select 5 from the Current Date - Days lookup.

8. Select 5 from the Current Date + Days lookup.

9. Select Save.

Updating the workbench period filter
The following steps describe how to update the workbench period filter

1. Select the Advanced Settings Menu.

2. Select Workbench.

3. Select Elements.

4. Double click Workbench (Employee).
5. Select Settings.

6. Select +/- 5 Days from the use period to filter lookup.

7. Select Save.

8. Repeat steps 1-7 for the Workbench (Equipment) element.

#6 - Make it easy for operators to track non-productive
time

(e.g. create Workbench buttons for non-productive codes)

MOM includes several possibilities for tracking non-productive time. The application is
pre-configured with a number of indirect diversions which by default are excluded from
posting to Work in Progress.

Pre-configured indirect diversions

DescriptionCode

Break
Break

Holiday
Holiday

Meeting
Meeting

Idle time
No Task

Sick leave
Sick Leave

Training
Training

Additional diversion codes can be created to meet the requirements of the organization.
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Creating an new diversion code
The following steps describe how to create a new diversion code.

Hi Colin,

Against the Assembly Terminal, we would like to track time spent on 'Staff Development'. We do not need
to post this time to Work in Progress. Staff Development would need to behave the same as Break from the
Workbench terminal.

Please action at your earliest convenience.

Thanks

1. Select the Advanced Settings Menu.

2. Select Definitions.

3. Select Diversions.

4. Select Custom.

5. Select New.

6. Enter Staff Development in the Code field.

7. Enter Staff Development in the Description field.

8. Select Indirect from the Type lookup.

9. Enter CLEAN in the ERP Non- Production Code field.

10. Select Downtime from theOperational field.

11. Select a Color from the color palette.

12. Select Save.

Creating a new task
The following steps describe how to create a new task.

1. Select the Advanced Settings Menu.

2. Select Definitions.

3. Select Tasks.

4. Select New.

5. Enter Staff Development in the Code field.

6. Enter Staff Development in the Description field.

7. Select Staff Development from the Diversion lookup.

8. Select Save.

Creating a new workbench status
The following steps describe how to create a new workbench status.

1. Select the Advanced Settings Menu.

2. Select Workbench.

3. Select Statuses.

4. Select New.

5. Enter Staff Development in the Status field.

6. Enter Staff Development in the Description field.
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7. Select the Pre-Defined Task Staff Development from the Task Code lookup.

8. Select Clocked Time Counted.

9. Select Codes.

a) Active Tasks
b) Back to Previous (Large)
c) Back to Previous (Small)
d) End Day (Entrance)
e) End Day (Large)
f) End Day (Small)
g) Scheduled Events
h) Stop all Tasks (Large)
i) Stop all Tasks (Small)
j) Timesheet Terminal Entry

10. Select Save.

Creating a new on-screen element
The following steps describe how to create a new On-screen element to change the
status to break.

1. Select the Advanced Settings Menu.

2. Select Workbench.

3. Select Elements.
4. Select New.

5. Enter Scheduled Break Start- 10:00 in the Code field.

6. Enter Scheduled Break Start - 10:00 in the Description field.

7. Select Break Start at 10:00 from the Execute by Schedule lookup.

8. Select Save.

9. Under the Functions tab, select New.

10. Select Status Change from the Function lookup.

11. Select Update.

12. Select Settings.

13. Select Break from the Target Status lookup.

14. Select Save.

15. Click on the Statuses Tab.

16. Select status codes Clocked-In, Meeting, Project and Training.

17. Select Save.

Creating a new non-productive code and job
The following steps describe how to add a new non-productive code and job.

Hi Colin,

Against the Assembly Terminal, we would like to track time spent on 'Cleaning'. Please setup a new
non-productive code in Work in Progress called CLEAN that we can post the time against.

Please action at your earliest convenience.
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hanks

1. Create a new Non-Productive Code in Work in Progress with code CLEAN.

2. Create a new Job in Work in Progress for non-stocked item CLEANING.

3. Create an operation against the Cleaning Job for MBFA01.

Creating a new diversion code
The following steps describe how to create a new diversion code.

1. Select the Advanced Settings Menu.

2. Select Definitions.

3. Select Diversions.

4. Select Custom.

5. Select New.

6. Enter Cleaning in the Code field.

7. Enter Cleaning in the Description field.

8. Select Indirect from the Type lookup.

9. Enter CLEAN in the ERP Non- Production Code field.

10. Select Downtime from theOperational field.

11. Select a Color from the color palette.

12. Select […] to open the Task lookup.

13. Select the Cleaning Job created in step 2 of previous task.

14. Select Save.

Creating a new on-screen element
The following steps describe how to create a new on-screen element for cleaning.

1. Select the Advanced Settings Menu.

2. Select Workbench.

3. Select Elements.
4. Select New.

5. Enter Cleaning in the Code field.

6. Enter Cleaning in the Description field.

7. Select Save.

8. Under the Functions tab, select New.

9. Select Button from the Function lookup.

10. Select 2/1 in the Size lookup.

11. Select Update.

12. Under the Functions tab, select New.

13. Select Status Change from the Function lookup.

14. Select Update.

15. Click Settings in the sequence 20 row.

16. Select Cleaning in the Target Status lookup.
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17. Select Save.

18. Under the Functions tab, select New.

19. Select Process Data in the Function lookup.

20. Select Update.

21. Click Settings in the sequence 20 row.

22. Select all Processing options.

23. Select Save.

24. Click on the Statuses Tab.

25. Select status codes Clocked-In.

26. Select the Terminals tab.

27. Select Assembly.

28. Select Save.

#7 -Track my work alerts

(i.e. add custom production issues for tracking and analysis)

MOM provides your organization with a number of pre-defined production issue codes
for reporting and analytical purposes. Additional production issue codes can be created
to meet the reporting and analytical requirements of the organization. Pre-Configured
Production Issue Codes

ClassificationCategoryType

BreakdownsBreakdownAvailability

Setup and AdjustmentsSetup and Adjustments

AccidentHealth & SafetyCustom

Near Miss

Loading IssueLoading

Cleaning/CheckingMinor StopsPerformance

Component Jams

Delivery Blocked

Equipment Wear

Obstructed Product Flow

Sensor Blocked

Operator InefficiencyReduced Speed

Rough Running

Under Design CapacityUnder Design Capacity

Production RejectsRejectsQuality

Startup RejectsStartup Rejects

Tracking production issues
The following steps describe how to track production issues.
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Hi Colin,

We would like to add a new production issue code for tracking power outages. We have experienced a few
power issues in the DRILL Work Center and need to identify if we are experiencing power outages anywhere
else in the factory.

Please action at your earliest convenience.

Thanks

1. Select the Factory Manager Menu.

2. Select Issue Maintenance.

3. Select New.

4. Select Performance from the Type lookup.

5. Select Minor Stops from the Category lookup.

6. Enter Power Outage in the Classification field.

7. Enter Power Outage in the Description field.

8. Select Save.

#8 -Track the reasons when we scrap product

(i.e. add scrap reason codes)

MOM provides your organization with a number of pre-defined scrap reason codes for
reporting and analytical purposes. Additional scrap reason codes can be created to
meet the reporting and analytical requirements of the organization. For integration of
scrap to Work in Progress, scrap reason codes must be created in MOM with matching
code values.

Pre-configured Scrap Reason Codes

Scrap DescriptionScrap Code

Dust contaminationDC

Damaged goodsDG

Early supplyES

Late supplyLS

Raw material quality problemRM

ScrapScrap

Adding a scrap reason code
The following steps describe how to add a scrap reason code.

Hi Colin,

We would like to add a new scrap reason code in MOM for tracking incorrect assembly. The reason code
(Incorrect) has already been setup in Work in Progress for this purpose.

Please action at your earliest convenience.

Thanks
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1. Select the Advanced Settings Menu.

2. Select Definitions.

3. Select Dropdowns.

4. Select New.

5. Select Scrap from the Type lookup.

6. Select Scrap from the Dropdown lookup.

7. Enter Incorrect in the Value field.

8. Enter Incorrect in the Description field.

9. Select Save.

#9 - Reduce the time required to review transactions

(i.e. apply transaction rules for exception based management)

Transaction rules are used to control how generated transactions will behave by default.
Transactions rules can be defined by transaction type, condition, diversion, employee
or equipment. Once configured, the default transaction status will be assigned based
on the default status value set in the transaction rule. This feature can be configured to
help streamline the review and approval process within your organization.

MOM includes 3 approval transaction statuses:

Approval Status Value

MeaningTransaction Status

Submitted transaction that requires approval before
posting to WIP

Submitted

Approved transaction that is ready to post to WIPApproved

Excluded from posting to WIPExcluded

MOM includes 3 pre-configured transaction rules.

Pre-configured Transaction Rules

Approval StatusTypeRule DescriptionRule

ExcludedEquipment TimeDo not post equipment
transactions

Exclude Equipment

ExcludedAll default diversionsExclude diversion
transactions

Excluded

ApprovedMaterial Issue and
Material Reject

A p p r o v e
Mater ial / Issue/Reject
Transactions

Issue/Reject

Note:

Transaction rules only apply to transactions generated from the Workbench.

Creating transaction rules
The following steps describe how to create transaction rules.
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Hi Colin, We would like to automatically approve all quantity transactions where the quantity is less than
1000.

This would help us streamline the approval process.

Please action at your earliest convenience.

Thanks

1. Select the Advanced Settings Menu.

2. Select Rules.

3. Select New.
4. Enter Quantity < 1000 in theCode field.

5. Enter Quantity < 1000 in theDescription field.

6. Select Approved from the Approval Status lookup.

7. Select the Type tab.

8. Untick Labor Time.

9. Select the Conditions tab.

10. Tick If Quantity is.

11. Enter 1000 in the than specified value field.

12. Select Save.

#10 - Set transaction management rights

(i.e. who can edit or delete transactions)

MOM provides the ability to control who can edit or delete transactions created when
collecting data from the shop floor. These permissions are often set as part of the
configuration. For more information on Transactions please refer to Workbench Step
#9 Review Transactions.

The permissions to edit or delete transactions can be set either:

1. Globally, from the General Advanced Settings.
2. Within the My Time On-Screen Element
3. Within the Timesheet Terminal Entry On-Screen Element

Preventing Transactions from being edited or deleted
The following steps describe how to prevent transactions from being edited or deleted.

Hi Colin,

We would like to prevent employees who access the Assembly terminal from editing or deleting transactions
through the My Time On-Screen Element.

Please action at your earliest convenience.

Thanks

1. Select the Advanced Settings Menu.

2. Select Workbench.
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3. Select Elements.

4. Check My Time (Small).
5. Select Copy.

6. Enter My Time (Assembly) in the Code field.

7. Select Settings on the Sequence 20 (timesheet) function.

8. Deselect the general options:

a) Allow transactions to be deleted
b) Allow transactions to be edited

9. Select Save.

10. Select Save.

11. Select Workbench.

12. Select Terminals.

13. Double Click on the Assembly Terminal.

14. Deselect the My Time (Small) On Screen Element.

15. Select the My Time (Assembly).
16. Select Save.
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Collect and Track - Processing
Frontline managers need complete visibility and control of the shop floor to prevent
problems such as overruns, downtime, poor employee or machine performance and
excessive scrap from occurring. Collecting this data by conventional methods can be
complicated, time-consuming and expensive.

MOM incorporates shop floor data collection (SFDC) from your employees and equipment
with options to automatically connect your machines in order to read data without manual
inputs, helping to digitize your factory (Industry 4.0).

The solution provides manufacturers with real-time shop floor visibility , helping to
eliminate manual processes and increase productivity. It enables you to execute
production plans while simply and accurately capturing and measuring activities on the
factory floor such as labor hours, materials issued, quantities reported, scrap and more.

Process Flow

The Workbench feature is an essential part of Workforce Manager. Designed to interact
with manufacturing workers and equipment on the shop floor, the Workbench typically
runs on portable devices such as tablets and iPads but can still be run on computers
and laptops. As Workforce Manager is a fully web enabled application, users can access
the Workbench from any remote location.Whether this is from a separate factory location
or whilst on the move from a mobile device, the Workbench is a scalable and flexible
data collection solution.
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Collecting Data

Recording labor against a job
The following steps describe how to record labor against a job.

1. Select the Workforce Menu.

2. Select Timesheet Entry.

3. Click […] in the Employee field.

4. Select Employee.

5. Select OK.

6. Click […] in the Task field.

7. Select Task.

8. Select OK.

9. Click […] in the Equipment field.

10. Select Equipment.
11. Select OK.

12. Enter 8 in the Hours field.

13. Click the + symbol.

14. Select Save

You can use the +/- symbol to create or remove lines to submit multiple lines of data
which are then saved to the Transactions Review.

The layout and default values provided in Timesheets can be customized by
Administrators within Advanced Settings.

Automatically approving transactions
The following steps describe how to automatically approve transactions.

Hi Colin

It has been noticed that it is very labor intensive to manually approve each timesheet entry.

Is it possible set these to approve automatically? Please action at your earliest convenience.

Thanks

1. Select the Advanced Settings Menu.

2. Select Timesheet.
3. Select Approved from the Set default approval status as dropdown.
4. Select Save.

Workbench

Login
The steps describe how to login each day.
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Hi Colin,

Dan Fisherman has started working for the company today and will need to be shown how to clock in to the
Entrance Terminal.

His employee ID is 110

Please action at your earliest convenience.

Thanks

1. Select Workforce Manager.
2. Select Workbench.

3. Select Terminals.

4. Select Entrance.

5. Enter 110 in the ID field.

6. Select Login.

Login at a terminal
The following steps describ how to login at a terminal.

Hi Colin,

Dan Fisherman has started working for the company today and will need to be shown how to clock in to the
Assembly Terminal and use all available functions. His employee ID is 110.

Please action at your earliest convenience.

Thanks

1. Select Workforce Manager.
2. Select Workbench.

3. Select Terminals.

4. Select Assembly.

5. Enter 110 in the ID field.

6. Select Login

Once the employee has clocked in, their status will change from Clocked Out to
Clocked In. This can be seen from the employee status screen.
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Sending messages
The following steps describe how to send messages.

1. Select Message.

2. Select New.

3. Enter Meeting Today in the subject field.

4. Enter Unfortunately I will unable to make today's meeting in the message body field.

5. Select Send.

The message will be sent automatically to Dan's line manager.The message center
indicator will change color on the line manager's screen to indicate they have a new
message.

Starting a schedule task
The following steps describe how to start a scheduled task.

1. Select Equipment - MBFA01 in the workbench header area.

2. Select Turn On.

3. Select Activity Run for Job 534 Operation 1.

4. Select Start.

Once the task has been started, the employee and equipment status indicators
change to a green bar which means Run activity is in progress. In addition, the job
status indicator changes to a green and grey bar. Meaning both employee (green
bar) and equipment (grey bar) are running the task.

Starting an un-scheduled task
The following steps describe how to start an ub-scheduled task.

1. Select Add Task.

2. Select Job 538.

3. Select Activity Setup for Job 538 Operation 1.

4. Select OK.
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Once the task has been started, the employee and equipment status indicators
change from a single green bar to a green and yellow bar. Meaning both Run and
Setup activity is in progress. In addition, the job status indicator changes to a green
and grey bar. Meaning both employee (green bar) and equipment (grey bar) are
running the task.

Manually raising a production issue
The following steps describe how to manually raise a production issue.

1. Select Job 538 from the employee workbench.

2. Select Production Issue.

3. Select Health & Safety .
4. Select Accident.
5. Select 538.1.Setup from the Task lookup field.

6. Select MBFA01 from the Equipment lookup field.

7. Select Dan Fisherman from the Employee lookup field.

8. Enter 0.5 in the Hours field.

9. Enter Cut finger during assembly in the Comments field.

10. Select OK.

As soon as the production issue is raised, the Issue Indicator will turn red to highlight
there is an issue to resolve.

In the earlier lesson 'Configuring Clock-in/out Terminals', you were taught how to
create an alert to notify the supervisor if there were any equipment failures in the
MBFA Work Center.The alert was configured to generate a production issue if down
for more than 5 minutes.

Raising a production issue based on status of equipment
The following steps decribe how to raise a production issue based on the status of
equipment.

1. Click on equipment MBFA/MBFA01.
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2. Select Equipment Failure.

3. Leave the equipment for 5 minutes

4. Click Back to Previous.

Assigning and resolving production issues
The following steps describe how to assign and resolve production issues.

Production issues can be assigned to users to investigate and resolve.

1. Click on the Issue Log.

2. Tick Issue to assign.

3. Select Assign.

4. Select Manager.

Once production issues are marked as resolved, the Issue Indicator will no longer
display red.

Issuing material
The following steps describe how to issue materials to a job.

1. From the Workbench Job List, click on Job 534 .
2. Select Issue Materials.

3. Click on Job 534 in the header section.

4. Enter 10 in the Job Qty field for Material B112.

5. Select OK.
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Kit issue of material
The following steps describe how to kit issue material to a job.

1. From the Workbench Job List, click on Job 534.

2. Select Kit Issue.

3. Enter 10 in the Job Qty field.

4. Select OK.

Additional information must be entered if the material is serialized, lotted or being
issued from a binned warehouse. This is achieved from the Material Issue screen
by clicking on the button to the right of the quantity field.

Fields will appear for the data that is required. You must split the entry by quantity
if the lot number, serial number or bin is a unique value.

Enabling material backflushing
The following steps describe how to enable material backflushing.

1. Select Settings.

2. Select Advanced Settings.

3. Select the Workbench Tab.
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4. Select the Elements Tab.

5. Locate the Workbench (Employee) on screen element.

6. Double click to edit the Workbench (Employee) on screen element.

7. Select Settings.

8. Select Reporting Options.

9. Select the option to Backflush Materials.

10. Select OK.

11. Select Save.

12. Select Close.

Reporting on non-productive time
The following steps describe how to report on non-productive time.

1. Select the Employee workbench.

2. Select Staff Development.
3. Select Back to Previous.

During the earlier lesson 'Terminals', you also created a new Non-Productive Task
for Cleaning which is to be posted to the CLEAN non-productive code in Work in
Progress.

4. Select the Employee workbench.

5. Select Cleaning.

6. Select Back to Previous.

End of Day - Clocking out
The following steps describe how to end the day for an employee by clocking out.

1. Click on the Employee workbench.

2. Select End Day.
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Tracking labor and issued materials
The following steps describe how to print a report of the labor tracked and materials
issued.

Hi Colin

Please provide a report of the labor tracked and materials issued for job 534.

Please action at your earliest convenience.

Thanks

1. Select Workforce Manager.
2. Select Job Status.

3. Double click on Job 534.

4. Select Export in the Operations Section.

5. Select Export in the Materials Section.

Tracking Process

Printing Dashboards
The following steps describe how to print dashboards.

Hi Colin

Please provide a print out of the Dashboard for this week for all employees and all equipment.

Please action at your earliest convenience.

Thanks

1. Select Workforce Manager.
2. Select Dashboard.

3. Click Select Employee.

4. Tick all Employees.
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5. Select OK.

6. Click Select Equipment.
7. Tick all Equipment.
8. Select OK.

9. Select Week from period dropdown.

10. Select the week that is current.

11. Click Refresh.

12. Select Print.

Printing Employee Status
The following steps describe how to privide a card print out of the current employee
statuses for all employees.

Hi Colin

Please provide a card print out of the current Employee Status for all employees.

Please action at your earliest convenience.

Thanks

1. Select Workforce Manager.
2. Select Employee Status.

3. Click Select Employee.

4. Tick all Employees.

5. Select OK.

6. Set the Productive Slider to ON.

7. Set the Non-Productive Slider to ON.

8. Set the Out Slider to ON.

9. Select Print.

Clocking an Employee out
The following steps describe how to clock off an employee.

Hi Colin

Please can you clock off employee Dan Fisherman (ID 110). He appears to be clocked in but had to leave
the office for an emergency meeting.

Please action at your earliest convenience.

Thanks

1. Select Settings.

2. Select Advanced Settings.

3. Select the General Tab.

4. Tick the option to Open Workbench from Current Status if not already ticked.

5. Select Save.

6. Select the Workforce Manager menu.
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7. Select Employee Status.

8. Click Select Employee.

9. Select Dan Fisherman.

10. On the Employee Card view click on Open Workbench.

11. Select End Day.

Printing equipment status
The following steps describe how to print the current equipment status for all equipment.

Hi Colin

Please provide a card print out of the current Equipment Status for all equipment.

Please action at your earliest convenience.

Thanks

1. Select Workforce Manager.
2. Select Equipment Status.

3. Click Select Equipment.
4. Tick all Equipment.

5. Select OK.

6. Set the Running Slider to ON.

7. Set the Not Running Slider to ON.

8. Set the Off Slider to ON.

9. Select Print.

Exporting current job status
The following steps describe how to export the current job status for all jobs.

Hi Colin

Please provide an export of the current job status for all jobs.

Please action at your earliest convenience.

Thanks

1. Select Workforce Manager.
2. Select Job Status.

3. Set the filter to (Select All).
4. Select Export.

Tracking labor and issued materials
The following steps describe how to print a report of the labor tracked and materials
issued.

Hi Colin

Please provide a report of the labor tracked and materials issued for job 534.
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Please action at your earliest convenience.

Thanks

1. Select Workforce Manager.
2. Select Job Status.

3. Double click on Job 534.

4. Select Export in the Operations Section.

5. Select Export in the Materials Section.
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Analyze and Improve

Attaching a static file to a job
The following steps describe how to attach files such as assembly instructions and/or
drawings to a job record.

1. Select the Document Library roundel.

2. Select Orders and then select the specific job record/s.

3. Select Add File and select Add File to Job.

4. Drag and drop or click to browse to attach your files to the selected jobs.

5. Select Save.

6. Select Close to return to the document library.
Attached files can be viewed from the Workbench and the Job Card.

Attaching a static file to an employee
The following steps describe how to attach files such as skills matrix to an employee
record.

1. Select the Document Library roundel.

2. Select Employee and then select the specific job record/s.

3. Select Add File and select Add File to Employee.

4. Drag and drop or click to browse to attach your files to the selected jobs.

5. Select Save.

6. Select Close to return to the document library.
Attached files can be viewed from the Employee record and from Employee
Performance.

Attaching a static file to equipment
The following steps describe how to attach files such as maintenance guide or service
schedule to an equipment record.

1. Select the Document Library roundel.

2. Select Equipment and then select the specific job record/s.

3. Select Add File and select Add File to Equipment.
4. Drag and drop or click to browse to attach your files to the selected jobs.

5. Select Save.

6. Select Close to return to the document library.
Attached files can be viewed from the Equipment record and from Equipment
Performance.
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Attaching a simple form to a job
The following steps describe how to attach a simple forms such as a checklist to a job
record.

1. Select the Document Library roundel.

2. Select Orders and then select the specific job record/s.

3. Select Add Form and select Add Form to Job.

4. Create your form or checklist in the WYSIWYG Editor

Note: You can copy and paste from Excel or Word (formatting may change).

5. Select Save.

6. Click Close to return to the document library

Note:  Attached forms can be viewed from the Workbench and the Job Card.

Linking to an online document library for a specific job
The following steps describe how to link to a document library for a specific job.

1. Select the Document Library roundel.

2. Select Orders and then select the specific job record.

3. Select Add Link and select Add URL to Job.

4. Place your cursor in the Link field.

5. Copy and paste the URL from your document management system library.

6. Place your cursor in the Link Description field.

7. Enter a description for the link (e.g. Shop Packet).

8. Select Save.

9. Click Close.

Note:  Links can be accessed from the Workbench and the Job Card. Ensure
that the tablet or panel PC device has been setup to view all of your file types
and formats.
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Conclusion

Helping you to become a World Class Manufacturer
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Appendices

Assessment: Users

1. Which authentication methods are supported for users connecting to Visual APS?

A. SQL and Windows authentication

B. SQL Authentication

C. Windows Authentication

D. None required

2. What authentication methods are supported for users connecting to the MOM
Website?

A. SQL Authentication

B. Windows Authentication

C. SQL and Windows authentication

D. None required

3. What must you assign to a user so they can receive rights to the access functionality
within the MOM Website?

A. Seat

B. Group

C: Role

D. All of the above

4. Which application requires SQL security to be configured before a user can logon?

A. MOM

B. Visual APS

C. SmartLYNQ

5.
Hi Colin

Please can you create a new role for finance and assign the management reports rights to this role.

Please action at your earliest convenience.

Thanks

Access User Maintenance via either Planning or workforce Manager. Select
New and enter a name & Description for this Role.Tick Management Reports
and Select Save.
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Assessment: Resources

1. Explain the steps required to add a new employee to MOM from Work In Progress?

A. User Maintenance > Seats > New > New Employee

B. User Maintenance > Seats > Activate

C. User Maintenance > Seats > Import > Import Employees

D. Resource Maintenance > Employee > Employee Maintenance

2. Explain the steps required to add a new machine to MOM?

A. User Maintenance > Seats > New > New Equipment

B. User Maintenance > Seats > Activate

C. Resource Maintenance > Equipment > Equipment Maintenance

D. User Maintenance > Seats > Import > Import Equipment

3. Which feature on the Home Menu in Visual APS should be used to configure
variations in time factors?

A. Machines

B. Alternatives

C. Constraints

D. Mapping

4. During the implementation of MOM all resources must be created in Work In Progress
and imported into MOM where appropriate.

A.True

B. False

5.
Hi Colin

We have a new worker 'Frank Lee' who will be the operator of a special drill we have purchased for
the drilling Work Center. The drill will arrive next week and both his employee account and equipment
record must be setup in Working in Progress and MOM.

Employee Code: 123457 Equipment Code: DRIL07

Please action at your earliest convenience.

Thanks

Use the Work in Progress module in SYSPRO under Setup to create a new
Employee and Machine. Use either Planning manager or Workforce Manager
to access User Maintenance. Select Import. Select Import Employee. Tick
Frank Lee and Select OK.Tick Frank Lee and Select Activate. Repeat the same
steps to Import and Activate the Equipment. The equipment will need to be
imported into Visual APS separately after refreshing the data. Use Home >
Import to Import for scheduling.
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Assessment: Shifts

1. What are working, non-working and downtime hour types?

A. Shifts

B. Activities

C. Mapping

D. Resources

2. Why are shifts required?

A. To define the available capacity of a Machine

B. To define the available capacity of an Employee

C.To define available capacity of a Resource

D. Shifts are not required

3. Shifts contain different activity types to identify working time from non-working time
and downtime.

A.True

B. False

4. Shift changes can be made to

A. Single Resource

B. Multiple Resources

C. Entire Factory

D. All the above

5.
Hi Colin,

Some MBFA & MBQA Work Centers will be working overtime Monday to Friday from September 1 to
December 18.

We will need a shift defined as follows:

• 08:00 to 12:00 Working Time
• 12:00: 13:00 Lunch Time
• 13:00 to 17:00 Working Time
• 17:00 to 20:00 Overtime
• 20:00 to 21:00 Maintenance Time
• The entire Factory will also be shut down on Nov 22 for Thanksgiving.

Please action at your earliest convenience.

Thanks

Visual APS> Home> Changes. Add new, enter Shift change code & define
activities as above. Select OK. Tick Work Centers MBFA & MBQA. Select on
Ungrouped to see newly created Shift. Right Select on the Shift and Select
Copy. Highlight dates as above & Right Select and Select Paste. Repeat for
the company shutdown remembering to select all Machines.
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Assessment:Terminals

1. Which field on the Create Terminal screen controls which equipment is available
from the Workbench?

A. Linked equipment

B. Default Equipment

C. Equipment Terminal

D. Access Control

2. Additional Terminals can be added by copying an existing Terminal.

A.True

B. False

3. Which 2 methods could be used to restrict which stock codes are visible to the
terminal users?

A. Apply access control

B. Edit Add Tasks on Screen element

C. Apply a Terminal data filter

D. Set Default equipment

4. How are you able to control which users can access a terminal?

A. Declare linked equipment

B. Apply data filters

C. Enable access control

D. Assign crew

5.
Hi Colin

We require a new terminal for the Bicycle Brake Assembly Work Center.

The terminal should be configured for the equipment codes MBBA01, MBBA02 and MBBA03.

Employees will require all elements of advanced terminal except for the Add Tasks Element.

Please action at your earliest convenience.

Thanks

Workforce Manager > Terminal Maintenance. Tick Advanced Terminal and
Select copy. Enter a Terminal name & Description. Untick Active Tasks on
screen elements. Use the Linked equipment field to select machines MBBA01,
MBBA02 and MBBA03 and Select OK. Select Save.

Assessment: Scheduling

1. From which 2 screens could you modify the planning interval?

153Manufacturing Operations Management (MOM) | SYSPRO EDUCATION
Copyright © 2018 SYSPRO (Pty) Ltd. All rights reserved.

All brand and product names are trademarks or registered trademarks of their respective holders.



A. Select Autoshift

B. Edit Settings

C. Home > Shift Changes

D. Schedule > Interval Planning

2. How is a marker applied to a job?

A. Highlight Job and select Manage > Markers

B. Right Select Job and select Markers from the menu

C. Review > Pin

3. How is material availability updated?

A. Schedule > Recalculate

B. Home > Refresh

C. Home > Recalculate

D. Plan > Recalculate

4. You are ready to firm your plan for a period of time, how would you prevent any
changes being made to the schedule?

A. Save and Publish

B. Add Markers

C. Pin advanced

D. Deadlines

5.
Hi Colin,

Job 520 is currently in dispute with the customer could you please place this job on hold.

Please action at your earliest convenience.

Thanks

Find Job by using a filter on the Job column. Unpin, unschedule, and remove
Critical Marker for this Job. Create a New Marker 'On hold' and apply to the
Job.

Assessment: Factory Performance

1. Where should you go to find information of actual current activity to gain insight into
how individual resources (employees and equipment) are performing today and
your actual product output (parts count)?

A. Planning

B. Workforce

C. Factory

D. All of the above
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2. You have been asked to provide details of planned equipment utilization for the
month ahead. Where should you go to see this information.

A. Planning > Dashboard

B. Factory > Availability then select equipment

C. Workforce > Equipment Performance

D. Planning > Equipment Plan

E. Factory > Equipment Analysis

F. Workforce > Equipment Status

3. How is equipment performance calculated?

A. Good Quantity / Produced (Total) Quantity

B. Planned Run Time x Production Quantity / Actual Run Time

C. Availability x Performance x Quality

Actual Productive Time / Planned Busy Time

4. You want to see what each employee is working on in the "final assembly" area
right now. Where can you find this information?

A. Workforce > Employee Status

B. Workforce > Employee Performance

C. Factory > Employee Analysis

D. All of the above

5.
Hi Colin,

We would like to start monthly performance reviews with our shop floor operatives. Can you provide
detail of our best performing employees for last month based on their OLE?

If you can, please send me the detail in Excel so that I can incorporate into our management pack.

Thanks

Factory > Employee Analysis > List (By Employee). Select the period you are
reviewing and Select the "OLE" column to sort the list descending leaving
your best performers at the top. Select "EXPORT" to send this list to Excel.

Assessment: Continuous Improvement

1. Select three (3) types of unplanned availability loss form the list below:

A.Tooling failure

B. In process damage

C. Component jam

D. Equipment breakdown

E. Operator shortage
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F. Operator inefficiency

G. Rough running

2. Select what is commonly known to be the Six Big losses from the list below:

A. Breakdowns

B. Idle time

C: Minor Stops

D: Planned changeover tie

E: No Shift

F: Loading loss

G: Setup and adjustments

H: Reduced speed

I: Startup rejects

J: Production rejects

3. How does SYSPRO Manufacturing Operations Management help with resolving
loss from operator shortages related to documentation?

A. it provides the ability to classify and quantify lost hours from missing
documentation.

B. It provides support for a paperless shop floor environment to ensure the right
documents are always there when you need them.

It provides links to document management system for version control and audit
trails.

All of the above.

4. When should you consider linking to a document management system?

A. When you need to provide audit trails to meet regulatory requirements.

B. When you need to show CAD files online.

C. When you need to provide simple forms and/or checklists for operators to
complete.

D. When you need to provide version control around your documents.

E. When you need to provide long term archiving control of your documents.

F. When you want to show assembly instruction videos.

5.
Hi Colin,

The continuous improvement team has now completed their FMEA (failure mode and effects analysis)
as a result of the loss we have been experiencing over the past few months from equipment breakdowns.
As a result, new equipment has been bought and has been in place since last month. Preventative
maintenance schedules have also been revised.

Can you provide detail to show what impact that this has had in reducing our loss from equipment
breakdowns? You know the guys like charts and details so anything you can provide here would be
great!
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Thanks

Factory > Availability. Run reports for this month. Use the tree map to show
the number of hours lost from "general breakdowns". Drill into the tree map
to get to the detail for general breakdowns. Export the detail to Excel.

Repeat for the comparative period and export to Excel. Create charts to map
one against the other to show improvement.

157Manufacturing Operations Management (MOM) | SYSPRO EDUCATION
Copyright © 2018 SYSPRO (Pty) Ltd. All rights reserved.

All brand and product names are trademarks or registered trademarks of their respective holders.



Epilogue

Copyright

All rights reserved. No part of this document may be copied, photocopied, or reproduced
in any form or by any means without permission in writing from Syspro Ltd. SYSPRO
is a trademark of Syspro Ltd. All other trademarks, service marks, products or services
are trademarks or registered trademarks of their respective holders.

Syspro Ltd reserves the right to alter the contents of this document without prior notice.
While every effort is made to ensure that the contents of this document are correct, no
liability whatsoever will be accepted for any errors or omissions.

This document is a copyright work and is protected by local copyright, civil and criminal
law and international treaty. This document further contains secret, confidential and
proprietary information belonging to Syspro Ltd. It is disclosed solely for the purposes
of it being used in the context of the licensed use of the Syspro Ltd computer software
products to which it relates. Such copyright works and information may not be published,
disseminated, broadcast, copied or used for any other purpose. This document and all
portions thereof included, but without limitation, copyright, trade secret and other
intellectual property rights subsisting therein and relating thereto, are and shall at all
times remain the sole property of Syspro Ltd.
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